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Introduction

DameWare Server provides a powerful, comprehensive remote control solution to 
support end users inside and outside your internal network seamlessly. You can securely 
authenticate to computers, troubleshoot and solve problems, and chat with end users on 
computers running Windows, Mac OSX, or Linux.

Key features include:

 l Controlling end users' computers inside and outside your internal network

 l Centralized licensing

 l The ability to create a global host list

 l A personal host list that technicians can access from any computer running the 
Remote Support or Mini Remote Control application in Centralized mode

 l The ability to connect to remote computers using your mobile device

The server version of DameWare software is available for centralized versions 11.0 and 
above. This mode requires you to install and deploy at least one server component—the 
DameWare Central Server. License activation occurs on the server level; you do not 
activate licenses on each computer with  Mini Remote Control  or Remote Support installed 
on it.  Mini Remote Control  and Remote Support users authenticate to the Central Server 
and can logon at any centralized  Mini Remote Control  or Remote Support installation. 
Centralized mode is most useful for organizations with a large user base, with large or 
centralized IT departments, or with multiple DameWare product licenses that you wish to 
manage from a single point.
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Installing the Server

DameWare Server includes the following discrete programs that you can install:

 l DameWare Server
 l DameWare Central Server component
 l DameWare Internet Proxy component
 l DameWare Mobile Gateway component

 l DameWare Server Administration Console
 l DameWare Remote Support with Mini Remote Control (Centralized mode)
 l Mini Remote Control client agent

You must request the server and associated executables from your SolarWinds sales 
representative.

Each program must be installed and configured on your network to fully utilize the 
DameWare Server. 

Use the following topics to install DameWare Server and related software:

Installing DameWare Server

 l System Requirements

 l Port Requirements

 l Installing the DameWare Server

 l Advanced Installation Options

 l Licensing and Activation
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Configuring DameWare Server Components

 l Configuration Guide

 l Express Configuration

 l Advanced Configuration

 l Configuring the DameWare Internet Proxy

Installing Remote Support and Mini Remote Control in Centralized Mode

 l Ports Used for Mini Remote Control

 l Selecting Your Install Type

 l Installing DameWare Remote Support or Mini Remote Control

 l Installing Remote Support or Mini Remote Control from the Command Line

Installing Mini Remote Control Client Agents

 l Mini Remote Control Client Agent Service Installation Methods

Installing the DameWare Server

System Requirements

Before you install the DameWare Server, review the following system requirements.

Hardware/Software Requirements

OS  l Windows Vista
 l Windows Server 2008 (including R2)
 l Windows 7
 l Windows Server 2012 (including R2)
 l Windows 8
 l Windows 8.1
 l Windows 10

Hard drive 
space

1 GB (2 GB or more recommended for database expansion)

CPU Quad core, 2.0 GHz or greater

RAM 4 GB (8-16 GB recommended)

.NET 
Framework

4.0

Note: If .NET is not present on the computer, you may be prompted 
to restart the computer after the .NET Frameworks are installed. 
Manually restart the computer, and run the installer again.

Network 100 Mbps or greater
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DameWare also installs the following components, which are embedded in the installer:

 l Microsoft Visual C++ 2008 SP1 Redistributable x86
 l Microsoft Visual C++ 2010 Redistributable x86 or x64              
 l Microsoft Visual C++ 2012 Redistributable x86 or x64 
 l Microsoft SQL Server Compact 4.0 Service Pack 1 x86 or x64 
 l MSXML 6.0 SP1 x86 or x64 
 l .NET Framework 4.0

If you are unable to complete the installation due to missing pre-requisites, download 
and install them separately.

Mobile Client requirements

The DameWare Mobile Client is supported on the following operating systems:

 l iOS 6.x and 7.x
 l Android 4.1-4.4

Port Requirements

DameWare listens to the following ports by default:

Port 
Number

Description Used with Com-
ponent or Product

Change the Default Port 
in...

Modify the 
port settings 
on...

443 DameWare Internet 
Proxy HTTPS - Used 
to connect computers 
through an Internet 
Session or download a 
Mini Remote Control or 
Internet Session agent

DameWare Internet 
Proxy

The Configuration Wizard N/A

6129 Mini Remote Control 
protocol - DameWare 
agents listen on this 
port for incoming 
remote desktop con-
nections

DameWare Mini 
Remote Control

DameWare Mini Remote 
Control application

Mobile Client 
in Global Set-
tings 

6130 DameWare Mobile Cli-
ent protocol - Gateway 
service listens on this 
port for incoming 
mobile connections

DameWare Mobile 
Gateway

Administration Console or 
the Configuration Wizard

Mobile Client 
on the gate-
way login 
screen

6132 Internet Session data 
stream between  Mini 
Remote Control and 
the DameWare Inter-
net Proxy

DameWare Central 
Server
DameWare Internet 
Proxy

The Configuration Wizard N/A
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Port 
Number

Description Used with Com-
ponent or Product

Change the Default Port 
in...

Modify the 
port settings 
on...

6133 Communication 
requests for 
DameWare Central 
Server components

DameWare Central 
Server
DameWare Internet 
Proxy
DameWare Mobile 
Gateway

The Configuration Wizard Remote Sup-
port, Mini 
Remote Con-
trol, and 
Administration 
consoles on 
the login 
screen

Optional ports for specific  DameWare features:

UDP  
137

Name Services port for 
File  & Printer Sharing, 
User and Computer 
Authentication

DameWare Remote 
Support
DameWare Mini 
Remote Support
DameWare Central 
Server

Windows systems set-
tings

N/A

138 Datagram Services 
port for  File & Printer 
Sharing

DameWare Remote 
Support
DameWare Mini 
Remote Support

Windows systems  set-
tings

N/A

139 Session Services port 
for  File & Printer Shar-
ing,User and Computer 
Authentication

DameWare Remote 
Support
DameWare Mini 
Remote Support
DameWare Central 
Server

Windows systems  
settings 

N/A

TCP and 
UDP 
445

Direct Hosting, 
NetBIOS for  File & 
Printer Sharing, User 
and Computer  
Authentication

DameWare Remote 
Support
DameWare Mini 
Remote Support
DameWare Central 
Server

Windows systems  
settings 

N/A

5900 VNC default port DameWare Mini 
Remote Support
DameWare Central 
Server

MRC connection settings 
and  in VNC configuration 
server

MRC con-
nection set-
tings and  in 
VNC con-
figuration 
server

88 Kerberos V5 port DameWare Central 
Server

N/A N/A

3389 RDP port DameWare Mini 
Remote Support
DameWare Central 
Server

MRC connection settings 
and  in Windows registry

MRC con-
nection set-
tings and  in 
Windows 
registry
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Port 
Number

Description Used with Com-
ponent or Product

Change the Default Port 
in...

Modify the 
port settings 
on...

Dynamic NTLM  port DameWare Central 
Server

N/A N/A

16993 Accessing Intel AMT  
secure(SSL)

DameWare Mini 
Remote Support

MRC connection settings 
and  in Intel AMT server

MRC con-
nection set-
tings and  in 
Intel AMT 
server

16992 Accessing Intel AMT DameWare Mini 
Remote Support

MRC connection settings 
and  in Intel AMT server

MRC con-
nection set-
tings and  in 
Intel AMT 
server

UDP 
and TCP 
389

For  LDAP to handle 
normal queries from cli-
ent computers to the 
domain controllers

DameWare Central 
Server

N/A N/A

TCP and 
UDP 53

For  DNS from client to 
domain controller and 
domain controller to 
domain  controller

DameWare Central 
Server

N/A N/A

TCP 636 Computer  Authentic-
ation over SLL

DameWare Central 
Server

N/A N/A

If you want to use Internet Session functionality, you must open port 443  in your 
organization's firewall to allow the DameWare Internet Proxy to communicate with users 
outside of your internal network.

Installing DameWare Server

The following procedure guides you through installing DameWare Server. You can choose 
to install all necessary software on a single computer (Express Install) or to install some 
of the software on different computers (Advanced Install)

Express Install 

Installs the following:

 l DameWare Server (DameWare Central Server, DameWare Internet Proxy, and 
DameWare Mobile Gateway) 

 l DameWare Server Administration Console

 l Remote Support with Mini Remote Control (Centralized mode)
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Advanced Install

Choose which software to install on the computer. At least one instance of each 
program must be installed on your network.

Notes: 

 l You may need to request the DameWare Server executable files from your 
SolarWinds sales representative.

 l You must run the installer as an administrator.

To install and configure DameWare Server:

 1. Log on as an administrator.

 2. Navigate to your download location and run the DameWare Server executable 
file.

 3. Review the welcome text, and then click Next to continue.

 4. Select I accept the terms in the License Agreement, and then click Next.

 5. If you want to install to a destination folder other than the default, click Browse, 
select an installation folder, and then click OK.

 6. If you want to install all DameWare Server software, select Express DameWare 
Server Install (Recommended), and click Next.

 7. If you want to install only part of the DameWare Server software (such as the 
Administration Console), select Advanced DameWare Server Install, and click 
Next. See Advanced Installation Options for more information.

 a. Select the software you want to install.

 b. Click Next.

 8. Select which application shortcuts you want the DameWare installer to create, and 
click Next.

 9. Click Install to begin the installation. The installer will install any pre-requisite 
software that is missing from the computer as well as the DameWare software.

 10. Enter the email address you provided to DameWare when you registered for the 
software, and click Continue.

 11. Click Finish to complete the installation and open the Configuration Wizard.

 12. Review the DameWare Server components, and click Next.

 13. If you want to turn on all DameWare Server components on the computer, select 
Express Configuration (Recommended for evaluation), and click Next.
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Installing the Server

 1. If you want to evaluate the Internet Session, click Test Connection and 
correct any errors.

 2. If you do not want to evaluate the Internet Session at this time, select I do 
not want to test the Internet Session URL (Skip this step), and click 
Next.

 14. If you want to turn on specific DameWare Server components on the computer, 
select Advanced Configuration (Recommended for production envir-
onment), and click Next.

 l Click Run Locally on components you wish to run from the computer.

 l Click Edit details to modify port numbers.

 l If the computer you are configuring hosts the Central Server and the other 
components are hosted on a different computer, click Connect Network 
Machine, and enter the host information.

 15. Note the default accounts, and click Finish. Use the default administrator account 
(user name: admin, password: admin) to logon to the Administrator Console.

For more information about Advanced Configuration choices, see Configuration Guide or 
Advanced Configuration.

After you have completed installing and configuring DameWare Server, log on to the 
DameWare Administration Console to add users, create a global host list, or modify your 
server settings.

Notes:          

 l To launch the  Mini Remote Control  or Remote Support applications or the 
Administration Console manually, navigate to Start > Programs > SolarWinds 
> DameWare <Product>, and select the application. You will need your 
DameWare Server user account information to logon.

 l If a shortcut is not added to the Windows Start Menu, open the Configuration 
Wizard from Start > Programs > SolarWinds > DameWare Server 
> DameWare Server Configuration Wizard, and run it again.

Advanced Installation Options

Using the Advanced DameWare Server Install option allows you to choose which software 
to install on your computer. You must install at least one instance of each program on 
your network to utilize DameWare Server fully.

The following is a list of software included in DameWare Server that you can select to 
install through the Advanced Install Options screen:
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DameWare Server 

Allows you to run DameWare Server components, such as the DameWare Central 
Server, DameWare Internet Proxy, and DameWare Mobile Gateway. Individual 
components can run on different computers. You must have one instance of 
the DameWare Server running to run the DameWare Internet Proxy. The 
DameWare Mobile Gateway can run independently of other DameWare Server 
components. 

DameWare Server Administration Console

Allows you to manage licensed users, sessions, shared information, and the 
centralized DameWare Server. You can install multiple instances of the 
Administration Console on your network. The Administration Console also does 
not need to be installed on the same computer as DameWare Server.

DameWare Remote Support (Centralized)

Allows you to access DameWare Server features, such as the global host list, 
Internet sessions, and centralized user licensing. Installing Remote Support also 
installs Mini Remote Control by default.

DameWare Mini Remote Control (Centralized)

Allows you to access DameWare Server features, such as the global host list, 
Internet sessions, and centralized user licensing. Installing Mini Remote Control 
also installs Mini Remote Control by default. To install only the centralized version 
of Mini Remote Control, clear the DameWare Remote Support checkbox.

Note: If you only installed the DameWare Server and then try to install another program 
using Advanced Install Options, the Remote Support and Mini Remote Control applications 
may not appear on the list. Request the Remote Support and Mini Remote Control 
installers from your SolarWinds sales representative and follow the instructions in 
Installing Remote Support or Mini Remote Control.

To view the Advanced Install Options:

 1. Log on as an administrator.

 2. Navigate to your download location and run the DameWareServer executable 
file.

 3. Review the welcome text, and then click Next to continue.

 4. Select I accept the terms in the License Agreement, and then click Next.

 5. If you want to install to a destination folder other than the default, click Browse, 
select an installation folder, and then click OK.

 6. Select Advanced DameWare Server Install, and click Next.
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 7. Select the software you want to install.

 8. Click Next.

 9. Select which application shortcuts you want the DameWare installer to create, and 
click Next.

 10. Click Install to begin the installation. The installer will install any pre-requisite 
software that is missing from the computer as well as the DameWare software.

 11. Enter the email address you provided to DameWare when you registered for the 
software, and click Continue.

 12. Click Finish to complete the installation.

Installing the Administration Console

 1. Log on as an administrator.

 2. Navigate to your download location and run the DameWareServer executable 
file.

 3. Review the welcome text, and then click Next to continue.

 4. Select I accept the terms in the License Agreement, and then click Next.

 5. If you want to install to a destination folder other than the default, click Browse, 
select an installation folder, and then click OK.

 6. Select Advanced DameWare Server Install, and click Next.

 a. Select the DameWare Server Administration Console.

 b. Click Next.

 7. Select which application shortcuts you want the DameWare installer to create, and 
click Next.

 8. Click Install to begin the installation. The installer will install any pre-requisite 
software that is missing from the computer as well as the DameWare software.

 9. Enter the email address you provided to DameWare when you registered for the 
software, and click Continue.

 10. Click Finish to complete the installation.

Licensing and Activation

DameWare software is licensed per user, but the centralized and standalone versions of 
the software handle the per user license differently. 

 l Centralized licensing

 l Standalone licensing

 l Centralized activation

 l Standalone activation
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Licensing

Centralized versions activate at the server and then use the Central Server as a licensing 
server to track the number of user seats. If you are deploying the Central Server on your 
network, you must use a centralized license.

Standalone versions allow you to activate a license up to three times per user. If you do 
not deploy the Central Server on your network, you must use the standalone license.

Notes:         

 l You cannot run both centralized and standalone versions at the same time.

 l You cannot upgrade from centralized to standalone. You must uninstall the 
software and then install the version you want.

  
Centralized
The centralized versions of DameWare software are licensed on the Central Server. Each 
product - DameWare Remote Support or DameWare Mini Remote Control - is activated 
from the computer on which the Central Server is installed. The DameWare Mobile 
Gateway is a feature of Remote Support that you activate on the computer with the 
Mobile Gateway installed on it. The DameWare Central Server and DameWare Internet 
Proxy are included with the centralized version of DameWare Remote Support and are 
not separately licensed.

The license includes a licensed user number. Each user is assigned a license type by a 
DameWare Administrator, which reduces the number of available user licenses. See 
Licensing Users for more information about assigning license types to users in 
DameWare Central Server. You can install the Remote Support or Mini Remote Control 
applications in centralized mode on multiple machines. 
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For example, if you purchased a centralized Remote Support license for 10 users, you 
activate the license on the Central Server and then assign licenses to up to 10 users. The 
users can logon with their DameWare credentials to any Remote Support or Mini Remote 
Control application in centralized mode.

Note: After your purchased license is applied, you must disable or delete any user 
accounts that exceed the number of licensed seats you have purchased.

 
Standalone
DameWare standalone software is licensed per user, and each license allows you to 
install on 3 computers.

For example, if you have 10 computers running Mini Remote Control and you use Mini 
Remote Control to manage 10,000 remote systems, you only need to license the 10 Mini 
Remote Control computers to maintain compliance with the SolarWinds End User License 
Agreement (EULA). To purchase licenses, visit www.dameware.com.

Complimentary Software
Certain DameWare software is not licensed, and you can install it as many times as you 
wish. The following DameWare software is provide free of charge and not licensed:

 l Mini Remote Control client agent

 l Internet Session Agent

 l DameWare Mobile Client

 l Administration Console

Activation

When upgrading to a new version or license, you do not need to reapply a license key if 
you have an Internet connection. Your license key will be automatically updated.

- 12 -
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If you are upgrading from DameWare Mobile Gateway to DameWare Server, deactivate 
your Mobile Gateway license, and then apply it to the computer running the DameWare 
Server Mobile Gateway component.

If your license is not automatically upgraded to reflect its status in the customer portal 
and you have an active Internet connection, you can manually sync the license key by 
opening the Licence Manager and clicking Sync. If you do not have a Sync button, you 
may need to upgrade your version of the License Manager.

If you do not have an active Internet connection, you must use the offline activation 
method.
 

Centralized
Centralized licenses are denoted by an extra "C" at the end ( DRSC or MRCC). Do not 
activate a centralized product if you do not have the correct license.

To apply a new centralized license:

 1. Browse to  http://support.solarwinds.com.

 2. Log in to the customer portal using your CustomerID/individual user profile email 
and password.

 3. Click License Management.

 4. Browse to your DameWare license list, and then locate the unregistered licenses 
list.

 5. Copy your unregistered activation key for the product you are activating to the 
clipboard.

 6. Click the Start menu and navigate to SolarWinds > DameWare Server 
> Activate DameWare Licenses.

 7. Click Enter License by the product you want to activate.

 8. Click Enter Licensing Information.

If the computer on which you installed the DameWare product is connected to the 
Internet, complete the following procedure.

 a. Click I have internet access and an activation key from my 
customer portal license management page.

 b. Paste your unregistered  activation key in the Activation Key field.
 c. If you use a proxy server to access the Internet, check the Proxy Server 

checkbox, and then type the proxy address and port number.
 d. Click Next.

If the computer on which you are activating your DameWare product is not 
connected to the Internet, complete the following procedure.

- 13 -
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 a. Click I want to activate my license through the Customer Portal.
 b. Complete the procedure described on the Activate Toolset window to 

complete the registration.

 9. Enter your contact information.

 10. Select the number of seats you wish to activate on the Central Server.

 11. Click Next.

 12. Click Finish.
Standalone
Standalone licenses do not have an extra "C" at the end ( DRS  or MRC). Do not activate a 
standalone product if you do not have the correct license.

To apply a new standalone license:

 1. Browse to  http://support.solarwinds.com.

 2. Log in to the customer portal using your CustomerID/individual user profile email 
and password.

 3. Click License Management.

 4. Browse to your DameWare license list, and then locate the unregistered licenses 
list.

 5. Copy your unregistered activation key for the product you are activating to the 
clipboard.

 6. Click the Start menu and navigate to SolarWinds > DameWare <product 
name> > Activate DameWare Licenses.

 7. Click Enter <product name> Licensing Information.

If the computer on which you installed the DameWare product is connected to the 
Internet, complete the following procedure.

 a. Click I have internet access and an activation key from my 
customer portal license management page.

 b. Paste your unregistered  activation key in the Activation Key field.
 c. If you use a proxy server to access the Internet, check the Proxy Server 

checkbox, and then type the proxy address and port number.
 d. Click Next.

If the computer on which you are activating your DameWare product is not 
connected to the Internet, complete the following procedure.

 a. Click I want to activate my license through the Customer Portal.
 b. Complete the procedure described on the Activate Toolset window to 

complete the registration.

 8. Enter your contact information.
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 9. Click Next.

 10. Click Finish.

Installing the DameWare Internet Proxy with Another Web Server

The DameWare Internet Proxy installs a web server to allow users to download Internet 
Session agents, handle proxy requests, and host Internet Session resources for users. It 
also creates and installs a self-signed security certificate for secure communications.

DameWare uses the http.sys web server engine, which IIS also uses. The http.sys engine 
allows multiple applications to use the same IP address and port number. However, two 
different engines cannot bind to the same port number.

You can turn on the DameWare Internet Proxy component on computers that already 
have a web server installed on them. 

Installing with IIS

When installing on a computer that has IIS installed, ensure that the Internet Session 
URL does not already exist. The Configuration Wizard creates the virtual directory from 
the Internet Session URL and cannot successfully create the path if it already exists. 

If you already use a third-party security certificate, the DameWare Internet Proxy does 
not create a self-signed certificate and uses the preexisting certificate instead. See 
Removing the Security Error for Internet Sessions for information on installing a third-
party security certificate on the DameWare Internet Proxy.

Installing with Other Web Servers (Apache, Tomcat, etc.)

When installing on a computer that does not use the IIS web server and http.sys engine, 
such as Apache or Tomcat, you cannot serve multiple applications out of the 
same port number. 

By design, most web servers only serve one application per port number. For example, if 
you already serve an application out of port 443, you cannot use port 443 with the 
DameWare Internet Proxy. To run the DameWare Internet Proxy on the same 
computer, you must use a different port number for each application.  

You can change the port number used by the DameWare Internet Proxy by changing the 
Internet Session URL in the Configuration Wizard. For example, if you want to run the 
DameWare Internet Proxy out of port 444 instead of port 443, change the Internet 
Session URL to https://domainName.com:444.

Additionally, the Internet Session URL cannot already exist in your directory structure. 
The Configuration Wizard creates the virtual directory from the Internet Session URL and 
cannot successfully create the path if it already exists. 
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If you already use a third-party security certificate, the DameWare Internet Proxy does 
not create a self-signed certificate and uses the preexisting certificate instead. See 
Removing the Security Error for Internet Sessions for information on installing a third-
party security certificate on the DameWare Internet Proxy.

Configuring the DameWare Server
Depending on your network and organization, you will have different configuration needs. 
This configuration guide addresses configuration for the most common deployment 
scenarios.

For all deployment scenarios, deployment consists of the following basic steps:

 1. Install the DameWare Server.

 2. Open the Configuration Wizard.

 3. Turn on a server component.

 4. Ensure that DameWare Server components can communicate with each other.

The following is a list of common deployment scenarios:

 l Express Deployment & Configuration (Recommended for Evaluation)
 l Two Server Deployment & Configuration  
 l Three Server Deployment & Configuration (Recommended for Production)

Note: If you want to use Internet Sessions to connect to users outside of your network, 
you must configure your firewall or router in addition to turning on the DameWare 
Internet Proxy. See Modifying Your Firewall or Router for more information.

Express Deployment & Configuration

This deployment scenario assumes you want to run all components from the same 
computer and is used during evaluations. Select Express Configuration in the 
Configuration Wizard to configure all components based on this assumption. This allows 
you to begin using the software quickly and with minimal input. However, when used in a 
production environment, this option is only suitable for smaller organizations. If you 
select this option and you want to use Internet Sessions to remote control users outside 
of your internal network, you must open port 443 on your external facing firewall. This 
may open your network to security risks that can be mitigated by installing the 
DameWare Internet Proxy in the DMZ (see Two Server Deployment & Configuration). 

In this scenario, install the DameWare Server once, and then run the Configuration 
Wizard using the Express Configuration selection to configure all components of your 
DameWare Server installation.
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Two Server Deployment & Configuration

In this scenario, the DameWare Central Server and DameWare Mobile Gateway server 
components run on the same computer and the DameWare Internet Proxy component 
runs on a computer in the DMZ. This configuration is generally used in small to medium 
organizations that want to use the DameWare Internet Proxy and Internet Sessions, but 
do not want to open their internal network to port 443.

In this configuration, you must install the DameWare Server and run the Configuration 
Wizard twice.

 1. Install the DameWare Server on your designated DameWare Internet Proxy 
computer.

 2. Run the Configuration Wizard on the computer, and select Advanced 
Configuration.

 a. Turn on the Internet Proxy.

 b. Click Edit details to obtain the pairing password and DameWare Internet 
Proxy host information.

 3. Install the DameWare Server on your designated DameWare Central Server and 
Mobile Gateway computer.

 4. Run the Configuration Wizard on the computer, and select Advanced Configuration.

 a. Turn on the Central Server and Mobile Gateway.

 b. Under the Internet Proxy, click Connect Network Machine.
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 c. Click Edit details under Internet Proxy, and enter the pairing password and 
host information for the DameWare Internet Proxy.

Three Server Deployment & Configuration  

This is the recommended configuration for DameWare Server. All components run on 
separate computers, and the DameWare Internet Proxy runs in the DMZ. This 
configuration handles large numbers of technicians using Remote Support, Mini Remote 
Control, or the DameWare Mobile Gateway at the same time. For extra security, you can 
also run the DameWare Mobile Gateway in the DMZ.

In this configuration, you must install the DameWare Server and run the Configuration 
Wizard three times.

 1. Install the DameWare Server on your designated DameWare Internet Proxy 
computer.

 2. Run the Configuration Wizard on the computer, and select Advanced 
Configuration.

 a. Turn on the Internet Proxy.

 b. Click Edit details to obtain the pairing password and DameWare Internet 
Proxy host information.

 3. Install the DameWare Server on your designated DameWare Mobile Gateway 
computer.

 4. Run the Configuration Wizard on the computer, and select Advanced 
Configuration.

- 18 -



Chapter 2

 a. Turn on the Mobile Gateway

 b. Click Edit details to obtain the pairing password and DameWare Mobile 
Gateway host information.

 5. Install the DameWare Server on your designated DameWare Central Server  
computer.

 6. Run the Configuration Wizard on the computer, and select Advanced 
Configuration.

 a. Turn on the Central Server.

 b. Under the Internet Proxy, click Connect Network Machine.

 c. Click Edit details under Internet Proxy, and enter the pairing password and 
host information for the DameWare Internet Proxy.

 d. Under the Mobile Gateway, click Connect Network Machine.

 e. Click Edit details under Mobile Gateway, and enter the pairing password 
and host information for the DameWare Mobile Gateway.

Express Configuration 

The Express Configuration option quickly configures all DameWare Server components 
with default values. 

Express Configuration uses the default port numbers and the host name of the computer 
on which the software is installed to configure the DameWare Central Server, DameWare 
Internet Proxy, and DameWare Mobile Gateway.

To run all components on the same computer (Express):

 1. If the DameWare Server Configuration Wizard does not automatically open, 
navigate to Start > Programs > SolarWinds > DameWare 
Server> DameWare Server Configuration Wizard.

 2. Review the installed components, and click Next.
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 3. In the DameWare Server Configuration Wizard, select Express Configuration 
(Recommended for evaluation), and click Next.

 4. If you want to evaluate the Internet Session, click Test Connection and correct 
any errors.
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 5. If you do not want to evaluate the Internet Session at this time, select I do not 
want to test the Internet Session URL (Skip this step), and click Next.

 6. Note the default accounts, and click Finish. 
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After you have completed installing and configuring DameWare Server, log on to the 
DameWare Administration Console to add users, create a global host list, or modify your 
server settings.

Note: To launch the  Mini Remote Control  or Remote Support applications or the 
Administration Console manually, navigate to Start > Programs > SolarWinds > 
DameWare Product, and select the application. You will need your DameWare Server 
user account information to log on.

Advanced Configuration

The Advanced Configuration option allows you to configure DameWare Server 
components when you run some or all components on separate computers. You can also 
use the Configuration Wizard to change port numbers, edit the Internet Session URL, 
modify the locations of DameWare Server components, or turn components on or off.

If you wish to run the DameWare Internet Proxy, which allows you to create Internet 
Sessions to help users outside your internal network, you must turn on both the 
DameWare Central Server and the DameWare Internet Proxy. These components can run 
on different computers.

The DameWare Mobile Gateway can run independently of the DameWare Central Server 
and DameWare Internet Proxy.

During configuration, you will need to know the following information about each 
component:

 l IP address or host name
 l Service port number
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 l Communication port number
 l Pairing Password (DameWare Internet Proxy and DameWare Mobile Gateway only)

To run the DameWare Central Server:

 1. Open the Configuration Wizard by navigating to Start > Programs > 
SolarWinds > DameWare Server> DameWare Server Configuration 
Wizard.

 2. Review the installed components, and click Next.

 3. Select Advanced Configuration (Recommended for production 
environment), and click Next.

 4. Under DameWare Central Server, click Run Locally.

 5. If you want to run other components on the same computer, click Run Locally 
under each component.

 6. If you want to run other components on different computers, click Connect 
Network Machine under each component.

 a. Enter the server information for each component.

 b. Click Save.

 7. Click Next.

 8. Note the default accounts, and click Finish. 

To run the DameWare Internet Proxy:

 1. Open the Configuration Wizard by navigating to Start > Programs > 
SolarWinds > DameWare Server> DameWare Server Configuration 
Wizard.

 2. Review the installed components, and click Next.

 3. Select Advanced Configuration (Recommended for production 
environment), and click Next.

 4. Under DameWare Internet Proxy, click Run Locally.

 5. Click Edit Details.

 6. Configure the Internet Session URL. See Configuring the DameWare Internet Proxy 
for more information.

 7. Click Test Connection and correct any errors with the Internet Session URL.

 8. Click Save.

 9. Click Next.

 10. Note the host information and pairing password, and click Finish. 

 11. Run the Configuration Wizard on the computer running the DameWare Central 
Server to enter the DameWare Internet Proxy information.
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To run the DameWare Mobile Gateway:

 1. Open the Configuration Wizard by navigating to Start > Programs > 
SolarWinds > DameWare Server> DameWare Server Configuration 
Wizard.

 2. Review the installed components, and click Next.

 3. Select Advanced Configuration (Recommended for production 
environment), and click Next.

 4. Under DameWare Mobile Gateway, click Run Locally.

 5. Click Next.

 6. Note the default account and host information, and click Finish. 

 7. Run the Configuration Wizard on the computer running the DameWare Central 
Server to enter the DameWare Mobile Gateway information.

After you have completed installing and configuring DameWare Server, log on to the 
DameWare Administration Console to add users, create a global host list, or modify your 
server settings.

Note: To launch the  Mini Remote Control  or Remote Support applications or the 
Administration Console manually, navigate to Start > Programs > SolarWinds > 
DameWare Product, and select the application. You will need your DameWare Server 
user account information to logon.

Configuring the DameWare Internet Proxy
If you have installed the DameWare Internet Proxy on a different machine than the 
Central Server, you need the component pairing password from the DameWare Internet 
Proxy when you run the Configuration Wizard on the DameWare Central Server 
computer. 

You should also verify the default Internet Session URL. You can skip this step and 
finalize the Central Server configuration or you can test the Internet Session URL. This 
ensures that users outside of your network will be able to join an Internet Session and 
download a DameWare agent if necessary.

For more information about configuring the DameWare Internet Proxy, see the following 
topics:

 l Setting the Internet Session URL

 l Modifying Your Firewall or Router

 l Testing the Internet Session Connection

 l Troubleshooting the Internet Session URL
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Component Pairing

When DameWare Central Server and the DameWare Internet Proxy or DameWare Mobile 
Gateway run on different computers, you must pair the components. Pairing components 
is essentially a key exchange between the DameWare Internet Proxy and the DameWare 
Central Server or the DameWare Mobile Gateway and the DameWare Central Server. By 
pairing the two components, each component is able to communicate successfully with 
the other. This also further secures communication between the two components.

To pair the components:

 1. On the computer with the DameWare Internet Proxy of DameWare Mobile Gateway 
running, open the Configuration Wizard.

 2. Click Next.

 3. Click Advanced Configuration (Recommended for production 
environment).

 4. Ensure the DameWare Internet Proxy or DameWare Mobile Gateway is running.

 5. Click Next.

 6. On the Configuration completed screen, copy the IP address or hostname, the 
connection port, and the pairing password.

 7. On the computer with the DameWare Central Server running, open the 
Configuration Wizard.

 8. Click Next.

 9. Click Advanced Configuration (Recommended for production 
environment).

 10. Ensure the DameWare Central Server is running.

 11. Under DameWare Internet Proxy or DameWare Mobile Gateway, click Connect 
Network Machine.

 12. Enter the IP address or hostname, the connection port, and the pairing password 
you copied from the Configuration Wizard on the DameWare Internet Proxy or 
DameWare Mobile Gateway.

 13. Click Save.

 14. Click Next, and then click Finish.

Note: If you move or change the location, host name, or IP address of a DameWare 
Server component that is paired with another component, you must pair the components 
again from the new location.
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Setting the Internet Session URL

The Internet Session URL is the base URL that all users see when initializing or joining an 
Internet Session. For example, the bold section of the following Internet Session link is 
the Internet Session URL that you set in the Configuration Wizard.

https://yourdomain.com:443/dwnl/?3285798686

This Internet Session URL can be an IP address or domain name. You can use an IP 
address or domain name that you already have, or you can create a custom path. If you 
create a custom path, this path cannot already exist in your Web directory. DameWare 
creates the virtual path using the entry you provide in the Internet Session URL field. The 
DameWare Internet Proxy may not start if the path already exists.

Notes:  

 l You cannot use special characters in the Internet Session URL.
 l Only HTTPs protocol is allowed. HTTP protocol will be automatically updated to 

HTTPs during installation of DameWare Server 12.0.
 l If you change the port for the Internet Session URL, Configuration Wizard auto-

matically verifies the bounded certificate on the new port.

If you own or operate your own website, you can use that domain name as your Internet 
Session URL. In this example, you use the Internet Session URL field in the 
Configuration Wizard to create a custom path, such as 
https://domainName.com:443/OverTheInternetHelp. 

The DameWare Internet Proxy also acts as a web server so that end users can download 
Internet Session agents, if necessary, to join Internet Sessions.

Modifying Your Firewall or Router

To successfully connect to Internet Sessions with users outside of your network, you 
must modify your externally facing firewall or router to forward TCP requests to the 
DameWare Internet Proxy. You must also allow ports 6130, 6132, and 6133 to listen for 
incoming requests.

All firewalls and routers operate differently. Please consult the manufacturers 
documentation for specifics, and use the information in this topic as a general guide.

When you install the DameWare Internet Proxy, you can install it on a computer with or 
without a pre-existing web server. See Installing the DameWare Internet Proxy with 
Another Web Server for more information.
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Note: Use the Test Connection button in the Configuration Wizard to ensure that 
outside users can communicate successfully through your firewall or router. See Testing 
the Internet Session Connection for more information.

DameWare Internet Proxy Installed without a Web Server
When you deploy the DameWare Internet Proxy on a computer without a web server, you 
or your network administrator must open port 443  on your firewall or router. Create a 
forwarding rule so that all TCP traffic going to your Internet Session URL is directed to 
your DameWare Internet Proxy instance. You must also allow ports 6130, 6132, and 6133 
to listen for incoming connections.

Note: If you do not have a security certificate from a certificate authority installed, end 
users may encounter security warnings if they download an Internet Session agent 
before joining an Internet Session.

DameWare Internet Proxy Installed with a Web Server
If you install the DameWare Internet Proxy on a computer that already hosts a web 
server, port 443 is open. Your network administrator must allow ports 6130, 6132, and 
6133 to listen for incoming connections. See Installing the DameWare Internet Proxy with 
Another Web Server for more information.

Notes: 

 l By design Apache cannot serve multiple sites out of port 443. If you are currently 
using HTTPS with Apache, you cannot co-locate the DameWare Internet Proxy on 
the same computer and use the same port number. see Installing the DameWare 
Internet Proxy with Another Web Server for more information.

 l Do not use a URL for your Internet Session URL that is already in use.

 l For the optional ports for specific DameWare features, see Port Requirements.

Why Must You Open the Ports?
443 (HTTPS)

The DameWare Internet Proxy uses port 443 (HTTPS) to communicate with Mini 
Remote Control and Internet Session agents on the end users' computers. The 
DameWare Internet Proxy also includes a web server, which allows end users to 
download the Mini Remote Control or Internet Session agent. The port number 
used can be modified where you configure the Internet Session URL. When  you 
configure the DameWare Internet Proxy using this port, the Configuration Wizard 
generates a self-signed certificate and installs it. If a certificate exists already, 
the Configuration Wizard uses that certificate and does not generate a self-signed 
certificate.
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6130 (Mobile Gateway Communication Port)

The Mobile Gateway listens to this port to allow communication between the 
Mobile Client and the agent on the remote computer. You can change this port 
number in the Configuration Wizard.

6132 (DameWare Central Server and DameWare Internet Proxy 
Communication Port)

DameWare Central Server and DameWare Internet Proxy listen to this port to 
allow communication between the Mini Remote Control application and the remote 
agent. This is specific to Internet Sessions. You can change this port number in 
the Configuration Wizard or the Administration Console.

6133 (DameWare Service Port)

DameWare uses this port to communicate between DameWare Server 
components. DameWare components listen to all communications inbound 
through this port. You can change this port number in the Configuration Wizard.

Common Issues When Configuring the Firewall or Router
Other websites may not start

If two or more websites are using port 443, non-DameWare products may not 
start. Change the port number on the other products, use different IP addresses, 
or install each product on separate computers.

Communication does not occur

If users cannot access the Internet Session URL or download agents, the ports 
may not be open. Check that changes were applied correctly and to the correct 
appliance. The Internet Session URL may also already exist on the computer.

Testing the Internet Session Connection

Testing the Internet Session URL ensures that the URL is accessible to out-of-network 
users and that technicians can connect to Mini Remote Control agents on off-network 
computers.

The Test connection button sends a request to a SolarWinds server, which then sends a 
TEST request to the Internet Session URL using TCP. 

 l If the request is successful, you will receive a confirmation and the DameWare Inter-
net Proxy is listed as verified. The Test connection button can only be used with 
port 443. 

 l If the request is not successful, a message is displayed saying that the Internet Ses-
sion URL is invalid or is not accessible from the Internet. This can be caused by:
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 l A firewall blocking the ports
 l Switching default routes (i.e., changing default gateway by route command), 

leading to the caching of a bad DMZ gateway into DameWare.Server.Service. 
This can happen if  the server in DMZ needs access to the Internet for updates, 
to install new features, etc. and then switches back to the normal state. If this 
happens, it is recommended that you restart your computer to clear the 
cache.

If you do not want to use the automated Test connection button, you can manually test 
the Internet Session URL by initializing an Internet Session and then joining the session 
from outside your network. The Configuration Wizard does not list the DameWare 
Internet Proxy as verified using this method.

Troubleshooting the Internet Session URL

If you have installed the DameWare Internet Proxy and you cannot successfully create an 
Internet Session, check the following:

 l Does another website use port 443 (HTTPS/SSL)?
The websites may interfere with each other.

 l Is Apache installed as the web server?
Apache allows only one site to use port 443. See Installing the DameWare Internet 
Proxy with Another Web Server for more information.

 l Are you using a URL that is already in use?
You cannot use a URL that already exists on your server. For example, if you use 
https://yourdomain.com/support, you cannot use that URL as the Internet Session 
URL.

 l Are the correct ports open on your router or firewall?
See Modifying Your Firewall or Router for more information.

 l Is the DameWare Internet Proxy running?
The DameWare Internet Proxy may be turned off. Check the Central Server and 
use the Configuration Wizard to start it.

 l Are there special characters in the URL?
Users receive an error if there are special characters in the Internet Session URL. 
Remove the characters by using the Configuration Wizard.

 l Did you change the port for Internet Session URL?
Configuration Wizard automatically verifies the bounded certificate on the new 
port. If bound certificate is not a DameWare certificate, you will be prompted to 
choose one of the following:

 n Yes:  SolarWinds recommends that you choose this option. This replaces cur-
rently bound certificate with DameWare's certificate.
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 n No: This allows you to continue using the unknown certificate. However, you 
may not be able to make remote connections over the internet if the agent of 
the target remote host is not setup to trust the certificate.

 n Cancel: This reverts any changes made. 
 n View Certificate: This opens new window with certificate details.

Installing Centralized Remote Support or Mini Remote Control
Before installing  Mini Remote Control, review the following information.

If a remote system is running the Mini Remote Control client agent service, Mini Remote 
Control only uses a single TCP port to connect to it. The default TCP port is 6129; 
however, you can specify any of the 65,000 valid TCP ports in the Mini Remote 
Control application properties. Since TCP 6129 is a well known port for the Mini Remote 
Control program, DameWare recommends you choose a different port to ensure the most 
secure connections.

If a remote system is not running the Mini Remote Control client agent service, Mini 
Remote Control attempts to install it over the remote operating system’s installed 
protocols for File & Printer Sharing.

Microsoft defines File & Printer Sharing as:

 l UDP 137 (Name)

 l UDP 138 (Datagram)

 l TCP 139 (Session)

 l TCP 445 (Direct Hosting)

If you do not want Mini Remote Control to install the client agent service using these 
ports, or if Mini Remote Control is unable to connect to the remote system using these 
ports, install the service using another installation method.

Selecting Your Install Type

You can install DameWare in two different, mutually exclusive modes—standalone or 
centralized.

DameWare Versions 11.1 and higher provide a separate standalone installer for Remote 
Support and Mini Remote Control (available from the Customer Portal). You must request 
the centralized version from your SolarWinds sales representative. The centralized 
installers force you to specifically choose centralized mode during the installation 
process.
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If you install DameWare Central Server, you must install Remote Support and Mini 
Remote Control in centralized mode. You cannot install both the use both Standalone and 
Centralized installations of DameWare.

Standalone

Standalone mode is the default installation type. Users who are upgrading or who have 
installed DameWare products before have installed pre-version 11 products in standalone 
mode. The standalone install type requires each product to be individually activated on 
each computer. It is most useful for organizations with a small user base or with small or 
decentralized IT departments.

Products installed in standalone mode do not require server equipment and cannot access 
Centralized features, such as global or personal host lists.

Centralized

Centralized mode is available for versions 11.0 and above. This mode requires you to 
install and deploy at least one server component—the DameWare Central Server. License 
activation occurs on the server level; you do not activate licenses on each computer with  
Mini Remote Control  or Remote Support installed on it.  Mini Remote Control  and Remote 
Support users authenticate to the Central Server and can logon at any centralized  Mini 
Remote Control  or Remote Support installation. Centralized mode is most useful for 
organizations with a large user base, with large or centralized IT departments, or with 
multiple DameWare product licenses that you wish to manage from a single point.

Products installed in centralized mode can access Centralized features,  such as the 
DameWare Internet Proxy or global host lists.

Installing the DameWare Remote Support or  Mini Remote Control  Applications

DameWare provides an intuitive wizard to guide your installation. You can also install the 
application using the command line. See Installing  Mini Remote Control  or Remote 
Support from the Command Line for more information. 

The following procedure will complete your installation of Remote Support  or Mini 
Remote Control  in centralized mode.

You need administrator privileges to install the  applications. If the computer on which 
you are installing Remote Support or Mini Remote Control has previously had a 
DameWare product installed on it, not including the Mini Remote Control client service, 
the previous settings are applied until you delete the DameWare database. Delete the 
DameWareDB file generally located in C:\Program Files (x86)\SolarWinds\DameWare 
<product>.
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To install the DameWare application using the installer:

 1. Log on as an administrator

 2. Navigate to your download location and launch the DameWareMRC or DameWareRS 
executable file.

 3. Review the Welcome text, and then click Next to continue.

 4. Select I accept the terms in the License Agreement, and then click Next.

 5. If you want to install to a destination folder other than the default, click Browse, 
select an installation folder, and then click OK.

 6. Select Centralized Install, and click Next.

 7. If you do not have the DameWare Central Server connection details, select I do 
not have the connection details now; I will enter the details later, and 
click Next.

 8. If you do have the DameWare Central Server connection details, select 
DameWare Central Server connection details (Recommended), and enter 
the IP address or host name of the Central Server and the port number. Click Next.

 9. Select which application shortcuts you want the DameWare installer to create.

 10. Click Install to begin the installation.

 11. Enter the email address you provided to DameWare when you registered for the soft-
ware, and then click Continue.

 12. Click Finish to complete the installation wizard and exit.

After you have completed installing the Remote Support or Mini Remote Control 
applications, launch the application by clicking DameWare Mini Remote Control or 
DameWare Remote Support in Start > Programs > SolarWinds.

Installing DameWare Remote Support or Mini Remote Control  from the Command Line

You can use command line options to install the Mini Remote Control application without 
being prompted for license information.

Notes:

 l You must run the commands with Administrator permissions
 l Use %WINDIR%\System32 instead of relative paths
 l You cannot install through a proxy server that also requires authentication

To install Remote Support  or Mini Remote Control  using the MSI installer:

Use the following command at the command line or in an installer script. Replace the 
variables in this example according to the values in the Arguments section.

msiexec /i fileName.msi /qn APPDIR="C:\Program Files\DameWare 
programName\" reboot=reallysuppress SILENT=yes INSTALLSTANDALONE=0 
CENTRALSERVERHOSTNAME=centralServerHostName
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To install Remote Support or Mini Remote Control   using the EXE installer:

Use the following command at the command line or in an installer script. Replace the 
variables in this example according to the values in the Arguments section.

fileName.exe /args "/qn APPDIR=\"C:\Program Files\DameWare 
programName\" reboot=reallysuppress SILENT=yes" 
INSTALLSTANDALONE=0 CENTRALSERVERHOSTNAME=centralServerHostName

Arguments
The following is a list of arguments you can use on the command line.

 l /args "argumentsHere" (EXE only) instructs the EXE installer to pass the argu-
ments inside the quotation marks along to the MSI installer.

 l APPDIR="C:\Program Files\DameWare programName\" specifies the installation 
directory. Enter Remote Support or Mini Remote Control in place of programName to 
use the default installation directory.

 l SILENT=yes instructs the installer to install the program silently.
 l SA_KEY=licenseKey (licensed only) contains the license key for licensed install-

ations. Enter a valid license key in place of licenseKey.
 l SA_EMAIL=emailAddress (licensed only) contains the administrator's email address 

for licensed installations. Enter a valid email address in place of emailAddress.
 l SA_FIRST_NAME=firstName (licensed - optional) contains the administrator's first 

name. Enter the first name in place of firstName.
 l SA_LAST_NAME=lastName (licensed - optional) contains the administrator's last 

name. Enter the last name in place of lastName.
 l SA_PHONE_NUMBER=phoneNumber (licensed - optional) contains the administrator's 

phone number. Enter a valid phone number in place of phoneNumber.
 l SA_PROXY_ADDRESS=proxyAddress (licensed - optional) contains the address of the 

proxy server the program should use to connect to the SolarWinds licensing server. 
If applicable, enter the proxy server's IP address or hostname in place of proxyAd-
dress.

 l SA_PROXY_PORT=proxyPort (licensed - optional) contains the port the program 
should use to connect to the proxy server. If applicable, enter the proxy port num-
ber in place of proxyPort.

 l INSTALLSTANDALONE=1 installs the standalone version. Use 0 to install the cent-
ralized version.

 l CENTRALSERVERHOSTNAME=centralServerHostName contains the DameWare Central 
Server's host name.

 l CENTRALSERVERPORT=portNumber contains the port number to the DameWare Cen-
tral Server. By default, this is 6133.

 l CSUSER=centralServerUser contains the login name of a Central Server user.
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 l CSPASSWORD=centralServerUserPassword contain the password of the Central 
Server user.

Installing Mini Remote Control agents

Mini Remote Control Client Agent Service Installation Methods

You can deploy the DameWare Mini Remote Control client agent to a single computer as 
needed or you can deploy to multiple computers at once.

If you want to deploy a single instance, you can deploy it to a remote computer in one of 
the following ways:

 l Installing the Service On-demand
 l Installing the Service from the Mini Remote Control Application
 l Installing Using MSI + MST Installers
 l Installing Using EXE Installers
 l Installing the Service Manually

If you want to deploy to multiple computers, you can deploy it in one of the following 
ways:

 l Deploying Custom MSI Packages

Note: The Mini Remote Control application is backwards compatible with Mini Remote 
Control client agents from version 7.0. If the Mini Remote Control application connects to 
an unsupported agent, it prompts you to install a newer version of the client agent.

The Windows operating system requires location Administrator rights to install, remove, 
start, stop, or upgrade the Mini Remote Control client agent service on remote systems.  

Installing the Service On-demand

When Mini Remote Control attempts to connect to a computer, it tries to connect through 
the client agent. If the client agent is not present on the remote computer, you are 
prompted to install the client agent.

Note:

 l The remote operating system must have the File & Printer Sharing protocols and 
the File & Printer Sharing ports opened.

To install the client agent service on-demand:

 1. Open a remote connection dialog by clicking File > Connect.
 2. Enter the Host Name or IP Address and administrative credentials.
 3. Click Connect.
 4. When prompted to install the client agent service, click OK. 
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Installing the Service from the Mini Remote Control Application

You can push the client agent to a computer using an option in the Mini Remote Control 
application console.

Note:

 l The remote operating system must have the File & Printer Sharing protocols and the 
File & Printer Sharing ports opened.

 l The remote agent may run in the following modes: 
 n Direct and remote connections: This enables you to connect to computers 

using on-premise access and off-premise access through DameWare Internet 
proxy.

 n Direct connection only: This enables you to connect to computers using on-
premise access only.

To install the service from the Mini Remote Control application:

 1. Click Install Service... from the File menu.
 2. Enter the host name or IP address of the computer on which you want to install the 

service.
 3. If you want to manually start the service each time a connection is opened, select 

Set     Service Startup type to "Manual" default is "Automatic".
 4. If you want to configure       the settings of the Mini Remote Control client agent service 

to copy to the     remote system, click the  Configure... button.
 5. If you want to copy     the DWRCS.reg file from the local system to the remote system 

with pre-configured Mini Remote Control client agent service settings, select 
Include Configuration File (DWRCS.reg). This option is available after you have 
created configuration settings.

 6. If you want to connect in FIPS Encryption Mode, select Copy     FIPS Modules 
(approximately 9 MB).

 7. Select Overwrite any existing configuration on remote host to recreate the 
configuration file in the remote machine.
Note: After pushing an agent with the Overwrite any exciting configuration on 
remote host functionality, you need to approve the agent on remote machine 
again.

 8. Click OK.

The Mini Remote Control application deploys the service to the remote computer.

Installing Using MSI + MST Installers

MSI installation contains the remote host, while MST contains the configuration for target 
host to be able to use it in the Remote mode.

The MSI and MST installers are saved at the following locations:
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 l MSI installer at  c:\Program Files (x86)\SolarWinds\DameWare Central Server-
\WebServerStaticContent\binary\

 l MST installer at c:\Program Files (x86)\SolarWinds\DameWare Central Server-
\WebServerStaticContent\binary\Remote Configuration\

To deploy the remote host with the remote configuration, open the command line and 
enter the transformation command:

msiexec /i DWRCS_Vista_64.msi  TRANSFORMS=transform_DWRCS_Vista_64.mst

Note: Add OVERWRITEREMOTECFG=1 to overwrite the remote configuration. By default, 
remote configuration is saved on the target machine.

Installing Using EXE Installers

You may install the remote hosts directly from extracting the installer (EXE) file.  The 
installer contains both the Remote Host installation (MSI) and Remote Host configuration 
(MST). EXE installer is located in the DameWare Proxy machine, and is unique for each 
proxy and configuration.

The EXE installer is saved at c:\Program Files (x86)\SolarWinds\DameWare Central 
Server\WebServerStaticContent\binary\

By default, remote host installation does not overwrite the Remote Host configuration. To 
apply a clear configuration, run the installation with OVERWRITEREMOTECFG=1.

Once you add the custom installation arguments, you must specify the default arguments 
as well. Otherwise, the remote host will be installed without configuration and will be run 
in Direct mode only. SolarWinds recommends to use the following command line 
arguments:

DWRCS_Vista_64.exe -ap "TRANSFORMS=transform_DWRCS_Vista_64.mst 
OVERWRITEREMOTECFG=1"

Installing the Service Manually
Notes:

 l In this installation method, agents will be available in Direct mode only, without 
Remote connection mode.

 l For manual installation with Remote connection support, copy DWRCSU.inst at  
c:\Program Files (x86)\SolarWinds\DameWare Central Server\ into the Remote 
Host folder at c:\Windows\dwrcs\ and restart the Remote Host.

To manually install the Mini Remote Control client agent service:

 1. Navigate to your DameWare installation folder, usually located at C:\Program 
Files\SolarWinds\DameWare Mini Remote Control.
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 2. Copy the following files to a location or device you can access from the remote com-
puter:    

 l DameWare.LogAdjuster.exe.config
 l SolarwindsDiagnostics.exe.config
 l DameWare.Diagnostics
 l cpprest110_xp_1_2.dll
 l DWRCChat.dll
 l DWRCK.dll
 l DWRCRSS.dll
 l DWRCSE.dll
 l DWRCSET.dll
 l DWRCSh.dll
 l DWSGRWRP.dll
 l ICSharpCode.SharpZipLib.dll
 l log4cxx.dll
 l log4net.dll
 l SolarWinds.Logging.dll
 l SolarWinds.Orion.Common.dll
 l DameWare.LogAdjuster.exe
 l DWRCS.EXE
 l DWRCST.EXE
 l SolarwindsDiagnostics.exe
 l DWRCS.Logging.xml
 l DWRCST.Logging.xml
 l LogConfigurations.xml

 3. On the remote computer, create a new folder in the Windows directory called 
"dwrcs" (C:\Windows\dwrcs).

 4. Place the copied files in the new folder.

Deploying Custom MSI Packages

Install the client agent on your local machine, and then use the DameWare MSI Builder to 
build a custom MSI package for the Mini Remote Control client agent service, including 
custom settings. You can then send the file to the remote system via your normal 
distribution process, such as group policies, or download it from the remote system, and 
then execute the installer. This installation method also opens the necessary TCP port on 
the Windows Firewall when it starts up. 

Note: Before you create your custom MSI package, you may want to pre-configure the 
client agent with host names, log settings, authentication choices, or other settings to 
deploy the custom configuration with the client agent.
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To build a custom MSI package for the Mini Remote Control client agent 
service: 

 1. Install and configure the client agent on the computer with the Mini Remote Control 
application.

 2. Open the DameWare Mini Remote Control Package Builder: Start > All Programs 
> SolarWinds > DameWare Mini Remote Control > DameWare Mini 
Remote Control Client Agent MSI Builder. 

 3. Complete the following fields in the Package Builder dialog:

 l Profile: Select a pre-defined MSI package profile to populate the rest of the 
fields with your preferred settings. To save a new profile, complete the rest 
of the Package Builder dialog, enter a new name in the Profile box, and then 
click the save icon.

 l Target O/S: The operating system on the target system(s).

 l Include FIPS Modules: Includes the FIPS Modules in the MSI package. 
These files are required to run the client agent service in FIPS Encryption 
Mode.

 l Install the mirror driver:  Includes the Mini Remote Control Mirror Driver 
in the MSI package.

 l Install the keyboard driver:  Includes the Mini Remote Control Virtual 
Keyboard Driver in the MSI package.

 l Install the smart card driver:  Includes the Mini Remote Control Smart 
Card Driver in the MSI package.

 l Client Agent Settings:  Click the Client Agent icon to open the Mini 
Remote Control client agent service settings dialog: 

 l When you configure these settings through the Package Builder, the applic-
ation saves the settings in the installer to deploy to one or more remote sys-
tems.

 l Output Folder: Enter or browse to the folder you want to install the service 
to on the remote system(s).

 4. Click Build MSI to build the MSI package and save it to the output folder, which is 
the DameWare installation folder by default.

You can deploy the custom MSI package as you would any other MSI.
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The Administration Console allows you to manage your DameWare Server installation, 
including managing user licenses and the Global Host List. You can manage the 
DameWare Central Server, the DameWare Internet Proxy, or the DameWare Mobile 
Gateway with the Administration Console.

If both the Central Server and the Mobile Gateway components run on the same 
computer, connect the Administration Console to that computer.

If the components run on different computers, use the IP address or host name of the 
computer with the server component you want to administer.

For example, if the DameWare Mobile Gateway is installed on 198.162.1.25 and the 
DameWare Central Server is installed on 198.162.2.50, enter 198.162.2.50 in the Server 
IP/Host Name field to connect the Administration Console to the DameWare Central 
Server. However, if both are installed on 192.168.3.75, enter that IP address to connect 
to both.

Connecting to the Central Server or Mobile Gateway
The Administration Console can be installed on any computer on your network that is 
capable of connecting to the computer(s) with DameWare Central Server and DameWare 
Mobile Gateway installed.

To connect to one of the DameWare Server components, you must have the following 
information:
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 l The DameWare Central Server and/or DameWare Mobile Gateway IP address or 
host name

 l The DameWare service port number (default is 6133)

You can connect using either Windows Authentication or Dameware Authentication.

 l You can use Windows Authentication only in cases where the Administration Console 
and the Central Server are in the same domain or are in different domains but those 
domains have built correct trust between them.              Also, the account must be impor-
ted/synced with the Active Directory server on the Central Server to make this type 
of authentication possible.

 l Windows Authentication uses the Active Directory credentials you used to log into 
your machine. If this account has not been assigned the administrator privileges, 
you cannot log on to the Administrator Console.

 l DameWare Authentication refers to DameWare specific user accounts that are inde-
pendent of your other credentials. The default administrator name is admin and the 
default password is admin. If your DameWare user account does not have admin-
istrator privileges, you cannot log on to the Administrator Console.

If you have deployed the DameWare Mobile Gateway on a different computer than the 
DameWare Central Server, you must use connection details for the computer with the 
DameWare Mobile Gateway to connect to the DMG.

To connect to the DameWare Central Server or DameWare Mobile Gateway:

 1. Open the Administration Console by clicking on the DameWare Administration 
Console icon, or by navigating to Start > Programs > SolarWinds > 
DameWare Server > DameWare Server Administration Console.

 2. The  DameWare Central Server or DameWare Mobile Gateway connection settings  
should be displayed. If not, or if you want to change these, select another con-
figuration from the Remembered Connections dropdown, or enter the required 
Server and Port.

 3. Note: You can save a server and port configuration as a Remembered Connection by 
clicking Save and entering a name.

 4. Either:
 l Select Windows authentication, to use the Active Directory credentials with 

which you logged into your machine and domain. 
                    Or:

 l Select DameWare authentication, and enter your DameWare username 
and password.
Note: If you have forgotten your password, contact your DameWare admin-
istrator to have it reset.

 5. Check Remember the last connection details, if you want these to save the above 
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details for the next time you log in.

 6. Click Connect to server. The Dameware Server Administration Console is 
displayed.

Default User Accounts
DameWare Central Server establishes two default accounts on your Central Server 
and/or Mobile Gateway - the admin and user accounts. These accounts can be disabled or 
enabled, and you can change the password for both accounts.

Admin account

Use the admin account to administer the DameWare Central Server with the 
Administration Console and perform tasks such as:

 l user creation
 l session management
 l password management
 l Global Host List management
 l Remote hosts management

This account does not count toward your license count and cannot be used in Remote 
Support,  Mini Remote Control, or Mobile Client.

User account

Use the default user account to login to the Central Server from Remote Support or Mini 
Remote Control. This user account has the  Mini Remote Control  & Remote Support 
license type which allows user to access both  Mini Remote Control  and Remote Support. 
User counts toward your license count and is editable.
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User accounts are fundamental to DameWare Server. Each person must have an enabled 
user account on the Central Server or Mobile Gateway. You can manually add users or 
import them. Each enabled user counts towards your license count.

DameWare user accounts are independent of your AD accounts. Permissions for 
interacting with remote computers depend on the credentials the user enters on the 
remote computer when connecting with the Mini Remote Control agent except when 
connecting using an Internet Session. Technicians initiating Internet Sessions connect 
with administrative credentials.

Use the following topics to learn more:

 l Adding Users

 l Disabling and Enabling Users

 l Importing Users

 l Editing Users

 l Deleting Users

 l Licensing Users

 l Administrator Permissions

 l Active Directory Synchronization Manager

Use the following topics to learn more:

 l Adding Users

 l Importing Users

 l Licensing Users
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 l Administrator Permissions

 l Active Directory Synchronization Manager

Use the following topics to learn more:

 l Adding Users

 l Importing Users

 l Licensing Users

 l Administrator Permissions

Adding Users
A user account must be created before you can connect to Remote Support, Mini Remote 
Control, or the Mobile Gateway. The DameWare Central Server and Mobile Gateway user 
accounts are separate from active directory accounts and are also separate from each 
other.

For example, a technician may be authorized to use Mini Remote Control from the Central 
Server, but unless the technician also has a DameWare Mobile Gateway user account, the 
technician cannot connect to the DameWare Mobile Gateway and remotely manage 
computers from a mobile device.

Only enabled users can connect, and each enabled user counts toward your licensed user 
count.

To add a user:

 1. In the Administration Console, select either Central Server or Mobile Gateway.
 2. Click Users.
 3. In the action toolbar, click the Add button.
 4. Enter an optional description. 
 5. Click Add New User.

Disabling and  Enabling Users
Only enabled users can log in to the gateway. Enabled users also count toward the 
number of licensed users.

Disabled user do not count toward the number of licensed users and cannot logon to the 
Remote Support or Mini Remote Control applications or the Mobile Gateway.

Note: Sessions opened before an account is disabled remain open until the session times 
out or is closed by the user or a DameWare Administrator.         

To disable an account:

 1. Select an enabled account.
 2. Click Disable.
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To enable an account:

 1. Select a disabled account.
 2. Click Enable.

You can select multiple user accounts at a time.

Importing Users
You can import users directly from Active Directory or from a CSV file. 

Active Directory Environment Requirements

Note: External links in this section were verified as of March 2015.

Mandatory Requirements

 l DameWare Mobile Client, Mini Remote Control  and Exporter must be installed on 
domain workstation, and run under domain user

 l DameWare Central Server must be installed on domain workstation
 l NTLM/NTLMv2 traffic and Kerberos authentication should not be disabled
 l You must synchronize domain users into DameWare Central Server

NTLM/NTLMv2

Windows uses NTLM or NTLMv2 protocols by default. You should not disable this protocol 
in local policy or group policy. If disabled, see the Microsoft article, How to enable NTLM 
2 authentication at the Microsoft support website.

If you are required to use NTLMv2 instead of NTLM, specify this options on all PC on which 
you want to use DameWare products.

Kerberos

Kerberos must be enabled on the Active Directory server. On most systems no additional 
configuration should be required. However, if required, the Microsoft TechNet web site 
has the following articles that may be useful:

 l Enable support for Kerberos authentication

 l Step-by-Step Guide to Kerberos 5 (krb5 1.0) Interoperability

Multi-domain authentication

Multi-domain authentication should work for trusted domains in one forest. When using 
transitive trust between domains in a forest, the Kerberos service searches for a trust 
path between the domains to create a cross-domain referral. In large trees it might be 
more efficient to establish cross-links of bidirectional trusts between domains where 
there is a high degree of cross-domain interaction. This permits faster authentication by 
giving the Kerberos protocol "shortcuts" to follow when generating the referral message. 
Kerberos authentication uses transparent transitive trust among domains in a forest.

Kerberos cannot authenticate between domains in separate forests. To use a resource in 
a separate forest, the user has to provide credentials that are valid for logging on to a 
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domain in that forest. Alternatively, if a one-way trust relationship exists, applications 
will use NTLM authentication, if the security policy permits. This scenario, however, is not 
supported.

Note: Single Sign-On cannot be used outside the Domain environment.

Additional information on these topics can be found at these external sites:

 l What Are Domains and Forests?

 l Single Sign-On Authentication

 l Introduction to Single Sign-On

 l What Is Kerberos Authentication?

 l Kerberos Authentication Events Explained

Active Directory Import

You can import users from Active Directory as Central Server users. This functionality is 
not available for DameWare Mobile Gateway users.

 Note: Importing from AD can take up to an hour depending on how large the imported 
groups are.

To import users from AD:

 1. Navigate to Central Server > Users.             
 2. Click AD User Import.  The Active Directory Import Wizard is displayed. 
 3. Select the import type:

 l To enable users to log in to the central server with DameWare credentials, 
select One-time import, and click Next.
Note: Users imported using this method will be standard DameWare users. 
They will not be able to use Windows authentication.

 l To enable users to log in to the central server with their Windows credentials, 
select Synchronized Import, and click Next. 
Note: This method sets up automatic synchronization with Active Directory for 
users in the selected groups.

 4. Select the domain to import from:
 l To import users from Active Directory groups on the local domain, select 

Local Domain.
 l To import groups from a custom domain controller:

 a. Select Custom domain controller  
 b. Enter the IP address or the FQDN of the domain controller                    
 c. Enter the Username and Password for a user account with read only 

or administrative access to Active Directory
 d. Enter the Port number of the Active Directory server. The default port 

number is 389 for LDAP or 636 for LDAPS servers                     
 e. If you are connecting to a LDAPS server, you can create an encrypted 

connection by checking the Use SSL box
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 5. Click Next.
 6. To filter the list of available active directory groups, enter all or part of the group 

name in the field beneath the list.
 7. Select the groups to import, and click Next.
 8. For each group, select the license type from the dropdown list. This can be either  

Mini Remote Control  or Remote Support. The number of available licenses for each 
product is displayed.

 9. If you are performing a one-time import, enter the default password for all users in 
these groups.
Note: Users are prompted to change this password when they first connect to the 
server.             

 10. If you are setting up a schedule:

 a. Enter a Connection Name for this schedule
 b. To schedule synchronization at a specific time on a specific day:

 i. Select the first Every button
 ii. Check the boxes for the days on which you want to synchronize with Act-

ive Directory
 iii. Select the time for the synchronization on each selected day

 c. To schedule synchronization at specified intervals:

 i. Select the second Every button
 ii. Enter the number of hours between imports

 11. Click Add.

AD Manager

The Active Directory Synchronization Manager enables you to  add, edit, delete and run 
Active Directory synchronization tasks.

 1. Navigate to Central Server > Users.
 2. Click AD Manager.

 l To add a new synchronized task, click Add. The Active Directory Import Wiz-
ard is displayed. Proceed from step 4 above.

 l To edit an existing Active Directory Synchronization Task, select the task and 
click Edit. The Active Directory Import Wizard is displayed. Proceed from step 
4 above, amending the task details as required.

 l To delete a synchronization task, select the task and click Delete.
 l To run a synchronization task immediately, select the tasks and click Syn-

chronize or click Synchronize All to synchronize all tasks.

CSV Import

DameWare provides a template to indicate how the data should be formatted in your CSV 
file.
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To download the template:

 1. Navigate to Central Server > Users or to Gateway > Users.
 2. On the actions toolbar, click CSV Import.             
 3. Click Download template file.
 4. Save the file to your computer or other device.

Note: You must keep the header from the template.

To import users:

 1. Navigate to Central Server > Users or to Gateway > Users.
 2. On the actions toolbar, click CSV Import.             
 3. Click Browse and select the CSV file.             

Editing Users
After users have been entered into the Central Server or Mobile Gateway, you can edit 
their accounts by selecting the user and clicking Edit in the action bar.

While any field in the user account can be edited, you will most likely be changing the 
password. You can change the passwords by selecting the account and clicking Change 
Password.

Deleting Users
You can delete a user to free a license seat or you can disable a user. DameWare 
recommends deleting accounts of users who are no longer employed by your 
organization.

To delete a user:

 1. In the Administration Console, navigate to Central Server > Users or Mobile 
Gateway > Users.

 2. Select a user.
 3. In the action toolbar, click Delete.

Note: If a selected user is synchronized with Active Directory, a warning message 
is displayed. Unless the user is deleted in Active Directory, it will be added back the 
next time the group containing this user is synchronized.

You can delete multiple accounts by selecting multiple users before clicking the Delete 
button.

Licensing  Mini Remote Control  or Remote Support Users
DameWare Central Server users are each assigned their own license. They can logon to 
any centralized install of Remote Support or Mini Remote Control and are not restricted to 
the three computer activations allowed per user on standalone installs. However, users 
may only use their Central Server credentials from a single computer at a time.
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The DameWare Central Server handles the product activation for Remote Support and 
Mini Remote Control. Central Server administrators create user accounts and assign 
licenses to them. Users can then authenticate through the DameWare Central Server and 
logon to any Remote Support or Mini Remote Control console in Centralized mode.

DameWare Central Server has two license types -   Remote Support and Mini Remote 
Control.

The  Remote Support  license type corresponds to a Remote Support license and allows 
users to access both Remote Support and Mini Remote Control. 

The Mini Remote Control license type corresponds to a Mini Remote Control license 
and allows users to access Mini Remote Control. The Mini Remote Control license type 
cannot use the Internet Session feature.

When you edit or create a new user, your available license count is displayed. This is the 
number of unassigned licenses you have. If you need more licenses, contact your sales 
representative for purchasing options.

DameWare Central Server Administrator Permissions
Users with administrator privileges have all rights and privileges in the DameWare 
Central Server and DameWare Mobile Gateway. Administrators have full privileges to 
manage users and sessions and to modify the DameWare Central Server, DameWare 
Internet Proxy, or DameWare Mobile Gateway settings. You cannot restrict or reduce 
administrator privileges.

The default administrator user does not consume a license because it is not licensed to 
use Remote Support, Mini Remote Control, or the DameWare Mobile Client.

Other accounts with administrator privileges enabled do consume a license can be used 
to logon to Remote Support, Mini Remote Control, or the Mobile Client.

Enabling administrator privileges grants a user administrative privileges within the 
DameWare Central Server or DameWare Mobile Gateway. These privileges do not 
override privileges that come from your directory service or from local user rights on a 
computer. Administrative privileges for the Central Server and the Mobile Gateway are 
marked separately in each component's Users section.

Active Directory Synchronization Manager
The Active Directory Synchronization Manager enables you to  add, edit, delete and run 
Active Directory synchronization tasks.

 l To add a new synchronized task, click Add. The Active Directory Import Wizard is 
displayed. See Importing Users, for more information.
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 l To edit an existing Active Directory Synchronization Task, select the task and click 
Edit. The Active Directory Import Wizard for this task is displayed. Amend the task 
details as required. See Importing Users, for more information.

 l To delete a synchronization task, select the task and click Delete.
 l To run a synchronization task immediately, select the tasks and click Synchronize 

or click Synchronize All to synchronize all tasks.
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The Remote Hosts list in the DameWare Administration Console contains the list of 
remote hosts that are deployed and are connected to the DameWare Proxy.

The remote host may have any of the following status:

 l Approved: Remote host is ready for use. In the DameWare Mini Remote Control 
console, approved hosts are visible in the Remote Host List if they are connected to 
the Internet Proxy. Remote hosts with Approved status may be online or offline, 
depending on whether the remote host is reachable by the Internet Proxy.

 l Pending: Remote host is waiting for approval from administrator before it can be 
used in DameWare Mini Remote Control. In the DameWare Mini Remote Control 
console, these hosts are not visible in the Remote Host List. Remote hosts with 
Pending status may be online or offline, depending on whether the remote host is 
reachable by the Internet Proxy.

 l Blocked: Remote host is offline as Internet Proxy forbids connection for these 
remote hosts. In the DameWare Mini Remote Control console, these hosts are not 
visible in the Remote Host List.

Approving, Blocking, and Deleting Remote Hosts
To approve a remote host, select the remote host from the list and then click Approve on 
the ribbon. The remote host becomes visible in the Remote Host List in the DameWare 
Mini Remote Control console.
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To block a remote host, select the remote host from the list and then click Block on the 
ribbon.  The remote host will not be able to establish connection.

To remove a remote host, select the remote host from the list and then click Delete on 
the ribbon. Once you remove a remote host, you will not be able to restore the 
connection using the DameWare Administration console.  To restore deleted connections, 
see Configuring Blocked or Inactive Connection.

Notes:

 l After changing the status, click Refresh to update the remote host information.
 l After approving a remote host, wait for five seconds to five minutes for the remote 

host to connect to the DameWare Proxy.

Auto-approving Remote Hosts
The DameWare Central Server allows you to approve remote hosts automatically.

To auto-approve remote hosts:

 1. In the DameWare Administration console, select Settings.
 2. In the Remote Host Auto-approve property, select Edit.
 3. In Value, select True to set to auto-approval.

When this feature is turned-on, the notification banner in the DameWare Administration 
console displays the message "Auto-approve is enabled. All remote host will be 
automatically approved."

When this feature is turned-off, the notification banner in the DameWare Administration 
console displays the number of remote host waiting for approval.

Notes:

 l For evaluation purposes, auto-approval is enabled by default.
 l When administrator logs in to the DameWare Mini Remote Control console, newly 

added hosts are auto-approved even when auto-approve is disabled in the 
DameWare Central Server.

Configuring Blocked or Inactive Connection

Configuring Blocked Connection

The DameWare Server stores information about deleted remote hosts in the database. 
The information stays in the DameWare database for 30 days. If necessary, you may 
restore them manually.
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To change this parameter, open the DameWare.Server.Service.exe.config file in the 
installation folder, and edit the property specifying the clearing interval for deleted hosts.

<add key="DeleteRemoteHostsPermanentlyAfterDays" value="30"/>

For example, change from value="30" to value="60".

Configuring Inactive Connection

If a remote host is inactive for 90 days, it will be automatically removed from the 
DameWare Server. The remote host then stays in the DameWare database for 30 days 
before permanent deletion.

To change inactivity interval, open the DameWare.Server.Service.exe.config file in 
the installation folder, and edit following property:

<add key="HideInactiveRemoteHostsAfterDays" value="90"/>

For example, change from value="90" to value="120".

Note: To turn off automatic removal or clearing the DameWare database, set the value 
to "0".
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Sessions are active connections between a server component and a client application or 
agent. Sessions are open until terminated by the user, by a DameWare Administrator, or 
if they are idle for too long. Users can have multiple sessions open at a time. 

DameWare Server has three session types.

Server Sessions 

Users create server sessions when they authenticate through the Central Server 
to logon to the Remote Support or Mini Remote Control applications.

Internet Proxy Sessions

When a user initiates an Internet Session, they create a session in the DameWare 
Internet Proxy.

Gateway Sessions

Gateway sessions are the connections between the Mobile Gateway and a Mini 
Remote Control agent.

You can see the number of sessions open to remote computers, view session details, and 
terminate sessions.

Use the following topics to learn more:

 l View Session Details

 l Terminating Sessions
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View Session Details
You can view session details, such as who opened it, how long it has been open, and the 
connected host. Session details vary depending on which type of session you view.

Note: You cannot view Central Server session details.

To view session details:

 1. Click Sessions.
 2. Select a session.
 3. Click Details .

Note: The Details button is visible for Gateway session.

Terminating Sessions
Sessions are closed in one of three ways:

 l Manually by a user
 l Manually by a Administrator
 l Automatically by the server or gateway

Manually by a user

Users close their own sessions when they disconnect from Remote Support, Mini Remote 
Control, an Internet Session, or from an agent.

Manually by an Administrator

An Administrator can terminate any session by selecting a session and clicking 
Terminate.

Automatically by the server or gateway

Inactive sessions are kept open for a configurable amount of time. Administrators can 
modify the session timeout in the Settings section. 
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The Global Host List is the host list that is available to all centralized Remote Support and 
Mini Remote Control users and to users connecting to the Mobile Gateway with version 11 
of the Mobile Client. This list is created by the DameWare Server Administrator in the 
Administration Console. Non-DameWare Administrators cannot edit the Global Host List.

Use the following topics to learn more about the Global Host List:

 l Creating the Global Host List

 l Importing to the Global Host List

 l Editing the Global Host List

Creating the Global Host List
You can manually enter hosts into the Global Host List or you can import hosts from a 
CSV, DWHL, or XML file or from AD. See Importing to the Global Host List for more 
information. Only DameWare Server Administrators can modify the Global Host List.

To add a host to the Global Host List:

 1. In the Administration Console, select Central Server.
 2. Click Global Hosts.
 3. In the action toolbar, click the Add Host button.
 4. Enter the host name or IP address.
 5. Select the Protocol Type.
 6. Click Add Host.
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To add a folder to the Global Host List:

 1. In the Administration Console, select Central Server.
 2. Click Global Hosts.
 3. Select the base folder in which you want to add another folder.
 4. In the action toolbar, click the Add Folder button.
 5. Enter the folder name.
 6. Click Add New Folder.

Importing to the Global Host List
A Global Host List allows all DameWare technicians to access a common host list. A 
Central Server administrator creates a Global Host List on the Central Server, and this 
list is displayed when a technician logs in to Remote Support or Mini Remote Control in 
centralized mode. Global Host Lists can only be edited in the Administration Console. 

You can import using Active Directory groups or using a file.

AD Import

You can import hosts from Active Directory to populate your Global Host List. 

Note: Importing from AD can take up to an hour depending on how large the imported 
groups are.

To import from AD:

 1. Navigate to Central Server > Global Hosts.

 2. Click Import From AD.

 3. Click Browse to open the Active Directory Import Wizard, and select a group.

 4. If you want to import a local work group,

 1. Select Local Domain, and click Next.

 2. Select which groups you want to import.

 3. Click Select.

 5. If you want to import a group from a domain controller,

 1. Select Custom domain controller.

 2. Enter user credentials that have read only or administrative access to Active 
Directory.

 3. Enter the IP address or FQDN of the domain controller.

 4. Click Next.

 5. Select which groups you want to import.

 6. Click Select.
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 6. Click Import.

 7. When prompted with the number of hosts to import, click Yes.

File Import

You can import XML, CVS, and DWHL files.

To import a host list:

 1. Under Central Server, click Global Hosts.

 2. On the actions toolbar, click Import from File.

 3. Click Browse, and select the host list file.

 4. Click Import.

CVS files must use the following format:

Hostname, IP-address, Alias
Hostname, IP-address, Alias

Each host is contained in a single line, and each host field is separated by a comma.

Editing the Global Host List
To edit an entry in the Global Host List:

 1. In the Administration Console, select Central Server.
 2. Click Global Hosts.
 3. Select a host.
 4. Click Edit Host in the Action bar.
 5. Modify the host entry.
 6. Click Save Changes.
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You can connect to users outside of your network by opening an Internet Session. This 
feature is only available with the Centralized version of DameWare Mini Remote Control
(version 11.0 or later).

To enable this feature you must configure the DameWare Internet Proxy and also open a 
port in your organization's firewall to allow connections between the Mini Remote Control 
application and the Mini Remote Control client agent on the computer outside of your 
internal network.

Use the following topics to learn more about Internet Sessions:

 l Limitations to Internet Sessions

 l Internet Session Troubleshooting Guide

 l Internet Session States

Limitations to Internet Sessions
While the Internet Session uses the Mini Remote Control agent, due to the way it 
communicates, it cannot use all of the features provided with the agent.

Note: You cannot connect to a Mini Remote Control client agent that is connected to the 
Internet through a proxy.

The following is a list of frequently used Mini Remote Control features that you cannot use 
in an Internet Session.
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 l Technician credentials/authentication

 l Simple File Transfer

 l Alternative connection protocols (RDP, VNC, AMT KVM)

 l Ping

 l Install, upgrade, or downgrade the MRC client agent

 l Lock Remote Keyboard and Mouse

 l Wake on LAN

The following table is a list of all Mini Remote Control agent features the Internet Session 
supports.

Tab Setting Notes

General Session Cannot connect to an agent with Shared 
Secret enabled.

Absolute Timeout  

Additional 
Settings

Show Tray Icon If this is disabled, users cannot manually 
join a session.

Only   Allow Connection When at 
the Logon Desktop

Enabling this setting prevents Internet 
Session connections.

Notify Dialog Notify   on Connection                       

Notify   Dialog Timeout                       

Play   Sound on Notify                       

Notify   on Disconnection                       

Notify   Dialog Caption                       

Notify   Dialog Text 1                       

Notify   Dialog Text 2 - Remote 
Control

                      

 

Internet Session Troubleshooting Guide
If you cannot successfully connect to another user with an Internet Session, please check 
the following.

Did you close the connection dialog?

The connection dialog must remain open while you wait for the End User to connect to the 
Internet Session. If it is closed, the Internet Session also closes.
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Are the DameWare Central Server and the DameWare Internet Proxy 
successfully paired?

Open the Configuration Wizard on both the computer with the Central Server running and 
the one with the DameWare Internet Proxy running. Ensure that the component pairing 
password from the Internet Proxy matches the component pairing password entered in 
the Configuration Wizard on the Central Server. See Component Pairing for more 
information.

Are the ports you use for the Internet Proxy open?

Ensure that the ports used for communication are open on the computer running 
DameWare Central Server and the DameWare Internet Proxy. Also ensure that the 
appropriate ports are open on your outward facing firewall and router. See Modifying 
Your Firewall or Router for more information.

Are the DameWare communication ports open on your DMZ?

If you have installed the DameWare Internet Proxy in your DMZ, you must open the 
DameWare communication ports on your firewall or router. See Port Requirements or 
Modifying Your Firewall or Router for more information.

Can you access the DameWare Internet Proxy from the Internet?

Open the Configuration Wizard on the computer with the DameWare Internet Proxy 
running. Click Next, and then click Advanced Configuration. Under DameWare 
Internet Proxy click Edit Details, and then click the Test connection button. 

If the test fails, try one of the following:

 l If you have changed any settings, click Save in the Internet Proxy Connection 
details screen.

 l Try to connect to the agent download page from both the internal network and the 
external network, located at https://<Internet Session URL>/dwnl/ where 
<Internet Session URL> is your Internet Session URL, including the custom path. If 
you cannot connect to the agent download page, try one of the other solutions on 
this page.

 l Open a command prompt and use tracert to see if the DameWare Internet Proxy IP 
address or host name is accessible from outside your internal network.

 l Open a command prompt and use netstat -a to see if another program is listening 
to the DameWare Internet Proxy port.

 l See if another web server is bound to the port number.
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Internet Session States
An Internet Session enters three states during its life cycle. You can view Internet 
Session States in the Admin Console by navigating to Internet Proxy > Sessions. Select a 
specific Internet Session by sorting by User Name (the technician who initiates the 
Internet Session) or Session ID.

Session Created

The Internet Session enters this state immediately after a technician initiates an 
Internet Session. The Internet Session stays in this state until it connects to the 
DameWare Internet Proxy.

MRC Console Connected

The Internet Session enters this state when it has connected to the DameWare 
Internet Proxy and the End User has yet to connect to the Internet Session.

Live Session

The Internet Session enters this state when the End User connects to the 
DameWare Internet Proxy using the Internet Session link. In this state, the 
technician can control the End User's computer and provide assistance. 
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Changing the Idle Time for Remote Support and Mini Remote Control  Users
Remote Support and Mini Remote Control users can only be idle for a set amount of time 
before the DameWare Central Server closes their server session and they are logged off 
of the Remote Support or Mini Remote Control applications. By default, the session idle  
time is set to 5 hours.

To modify the idle time:

 1. Navigate to Central Server > Settings.

 2. Select Session expires in (hours).

 3. Click Edit in the Action bar.

 4. Enter the idle time in hours. Users can be idle from 1-24 hours.

 5. Click OK.

Remote Host Port Forwarding
The Internet Proxy communication type setting allows you to choose to use port 
forwarding between Remote Host applications and the DameWare Internet Proxy. This 
allows Remote Hosts to have transparent access to the  Internet Proxy.

Forward through the Central Server

Select this option to use the Central Server to forward Remote Access traffic to 
the DameWare Internet Proxy. You must enter a port number in the Proxy 
listening port field. Any communications directed to that port will be forwarded 
to the Internet Proxy. The default is 443.
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Forwarding off (default)

Select if you do not want to forwarding traffic from the Central Server to the 
Internet Proxy. The application will communicate directly with the  Internet Proxy. 
No additional set up is necessary.

Forward through a custom router

Select to use a router to forward Remote Host traffic to the Internet Proxy. The 
router must be configured to forward communication requests to the 
DameWare Internet Proxy. This is a separate step that must occur on the router. 
You must also enter the IP address or host name of the router and the port 
number  designated on the router for DameWare Internet Proxy requests. 

To modify the port forwarding setting:

 1. Go to Internet Proxy > Settings.

 2. Select Remote Host Port Forwarding.

 3. Click Edit in the Action bar.

 4. Select the Forwarding type.

 a. If you select Forward through the DameWare Central Server, enter the 
proxy listening port number. The default is 443.

 b. If you select Forward through a custom router, enter the router 
IP address or host name and the proxy listening port.

 5. Click OK.

Note: Changing this port forwarding setting is not automatically propagated to already 
installed remote agents. Existing remote agents need to be reinstalled in order for the 
new port forwarding setting to take effect. Note that this setting does not impact whether 
a remote host can be remotely connected to. Using port forwarding simply allows a newly 
deployed remote host to show up in the admin console for approval while still connected 
directly to the internal LAN.

Changing the Number of Concurrent Internet Sessions
The number of concurrent Internet Sessions the DameWare Internet Proxy can support is 
based on the hardware capacity of the computer on which the DameWare Internet Proxy 
is installed. By default, using the minimum system requirements as a base, the 
DameWare Internet Proxy can support at least 100 concurrent Internet Sessions.

To modify the number of concurrent Internet Sessions:

 1. Navigate to Internet Proxy > Settings.

 2. Select The maximum number of concurrent Internet Proxy connections.

 3. Click Edit in the Action bar.

- 63 -



Managing Server Components

 4. Enter the maximum number of concurrent Internet Sessions. 

 5. Click OK.

Modifying the Internet Session Base URL

 1. Navigate to Internet Proxy > Settings.

 2. Select The base URL for Internet sessions.

 3. Click Edit in the Action bar.

 4. Enter the Internet Session base URL.

 5. Click OK.

Notes:

 l You may modify the Internet Session Base URL by adding /TEXT after the local host-
name. For example, https://localhost/TEXT.    

 l You cannot modify the local hostname and port. Modification to the local hostname 
and port may be done in Configuration Wizard.    

Changing the Number of Concurrent Mobile Client Sessions
The Mobile Gateway can support up to 100 concurrent mobile user sessions at a time. 
Changes to this setting takes effect immediately.

If you reduce the number of concurrent sessions and the current number of active 
sessions are greater than your new limit, the sessions are not prematurely closed. No 
new sessions are created until the number of concurrent sessions is less than your new 
limit.

To edit the number of concurrent mobile client sessions:

 1. Navigate to Gateway > Settings.

 2. Select The maximum number of concurrent mobile client sessions.

 3. Click Edit in the Action bar.

 4. Enter the maximum number of concurrent mobile client sessions. DameWare 
supports 5-250 concurrent sessions.

 5. Click OK.

Changing the Idle Time for Mobile Clients
This setting controls how long a session can be idle before it is closed. The minimum is 
one minute. DameWare recommends shorter idle times. Changes to this setting take 
effect immediately.
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 1. Navigate to Gateway > Settings.

 2. Select Session is terminated after number of minutes in idle state.

 3. Click Edit in the Action bar.

 4. Enter the idle time in minutes. The minimum is one minute.

 5. Click OK.
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Integrating Mini Remote Control with Web Help 
Desk

What is Web Help Desk Integration?
Integrating DameWare Mini Remote Control  into Web Help Desk (WHD) allows you to 
seamlessly move from WHD to Mini Remote Control and save Mini Remote Control 
information to a WHD ticket.

When Mini Remote Control opens from Web Help Desk, Mini Remote Control opens in 
Web Help Desk Integration mode. This mode allows you to save information gathered 
from a remote support session in Mini Remote Control to a Web Help Desk ticket. A 
banner displays during the session when Mini Remote Control runs in Web Help Desk 
Integration mode.

Create a Mini Remote Control session in Web Help Desk integration mode from a 
WHD asset. This immediately connects you to the asset or remote computer. If the asset 
is not on your local network, or if the asset is not part of your Saved Host list, the Remote 
Connect dialog displays. You can create an Internet Session or add the asset to your 
Saved Host list.

After you complete your troubleshooting steps in Mini Remote Control and close the 
session, you are prompted to save session details, chat transcripts, and screenshots to a 
WHD ticket. Session details include:

 l Technician IP address

 l Client IP address

 l Session start time

 l Session end time

 l Session duration

 l Session termination reason

 l Technician notes

Session details are saved to the ticket as a note and any chat transcripts or screenshots 
are saved to the ticket as attachments. 

Web Help Desk Integration mode requires some configuration changes in WHD (See 
Enabling DameWare Integration on WHD for more information) in addition to an install of 
the Mini Remote Control application and the Mini Remote Control agent installed on each 
remote computer or asset. The configuration change creates a custom protocol handler 
(dwrcc) that is associated with the Mini Remote Control application on the local computer.
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Notes: 

 l Depending on your security settings, you may be prompted to allow the DameWare 
protocol handler to resolve and open Mini Remote Control.

 l MRC cannot install an agent when running in integration mode. The agent must 
already be present on the remote computer or asset.

 l You cannot create a chat only session in Web Help Desk Integration mode.

Integrating with Web Help Desk
Successful integration with Web Help Desk requires the following:

 l Web Help Desk administrator privileges (to set up the integration)

 l The Mini Remote Control application installed on each technician computer

 l The Mini Remote Control agent installed on each remote computer or asset

 l A valid IP address for each asset

Note: You do not need to perform any configuration in Mini Remote Control 11.1 or 
higher to integrate with  Web Help Desk v 12.2.0

WHD Administrator Privileges

You must have administrator privileges in WHD to integrate the two products.

To configure the DameWare and WHD Integration:

 1. Logon to Web Help Desk.

 2. Navigate to Setup > Assets > Options.

 3. Select DameWare Integration Links Enabled.

 4. Click Save.

This creates a registry entry in your Web Help Desk installation that is used to open Mini 
Remote Control. 

Mini Remote Control installed

The Mini Remote Control application must be installed on each technician computer that is 
used both to access WHD and to open a Mini Remote Control connection. When you open 
a Mini Remote Control connection from WHD, the protocol handler opens the local copy of 
MRC. If Mini Remote Control is not installed on the local computer, you cannot create a 
Mini Remote Control session from Web Help Desk.

The Mini Remote Control agent installed

A Mini Remote Control connection in Web Help Desk Integration mode does not allow you 
to add or remove agents from the remote computer or asset. All assets must already 
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have the Mini Remote Control agent installed on them before Mini Remote Control can 
connect to them.

Note: You do not need to pre-install the Mini Remote Control agent to create Internet 
Sessions. Users download the Internet Session agent or Mini Remote Control agent from 
the DameWare Internet Proxy server.

Valid IP address

Each asset must have a valid IP address associated with it in WHD. If  an asset does not 
have a valid IP address, the Remote Connect dialog displays.

 

Starting Mini Remote Control from Web Help Desk
You can create a Mini Remote Control session from Web Help Desk from either a ticket or 
an asset.

Note: When saving DameWare information to WHD, you must have a ticket number or 
create a new ticket so that the information can be saved to WHD.

To start Mini Remote Control from a ticket:

 1. Open a Web Help Desk ticket.

 2. Navigate to Asset Info > Ticket Asset.

 3. Click the DameWare integration button .

After you close the session, you can choose to save the session details, chat logs, or 
screenshots to the WHD ticket.

To start Mini Remote Control from an asset:

 1. Search for the asset.

 2. Click the DameWare integration button .
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You can also open Mini Remote Control from within the asset.

When you close the session, you are prompted for your WHD credentials (see Why Do I 
Need to Connect to Web Help Desk for more information) and then to either select a 
ticket or to create a ticket  to upload the DameWare information to.

Why do I Need to Connect to Web Help Desk?
When you close a session in Web Help Desk Integration mode, you are prompted for your 
Web Help Desk credentials. Since DameWare and Web Help Desk are separate 
applications with separate authentication methodologies, this prevents common 
authentication issues when creating or modifying a Web Help Desk ticket with DameWare 
information.

Enter the user name or email address and password that you use to login to WHD. You 
may need to confirm the location of WHD in the Connection details tab.

You may also need to accept the certificate from Web Help Desk. If you do not accept the 
certificate, you will not be able to upload information to the WHD ticket.

If you want DameWare to store your credentials, select Remember and do not show 
again where you are prompted for your WHD credentials.

You can change your credentials by deleting the saved credentials. Click View > Local 
Global Options > Additional Options to delete the credentials. You will be prompted 
for your credentials during the next time you need to login to WHD.
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Matching Component Version Numbers
DameWare Server component version numbers must all match to ensure that all 
components can communicate successfully with each other. If there is a version 
mismatch, reinstall the mismatched component to the correct version number, and run 
the Configuration Wizard again.

To determine the version number:

 1. Logon to the computer with the DameWare Server component.

 2. Navigate to Control Panel > Programs.
If necessary, select Uninstall a Program.

 3. Find the DameWare component in the Installed Programs list. You may need to 
scroll to the right to find the version number.

IPv6 and the DameWare Internet Proxy
DameWare uses the netsh tool to establish port forwarding through the DameWare 
Central Server between your Mini Remote Control application and the DameWare 
Internet Proxy. This port forwarding is used for Internet Sessions.

You are prompted to install the IPv6 protocol when it is not present on the computer on 
which you have installed the DameWare Central Server. 

If you install the IPv6 protocol, it is installed on the machine running DameWare Central 
Server. The Internet Proxy communication type is set to Forward through the 
Central Server in the Administration Console. You can change the port number (the 
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default is 6132) in the DameWare Server Configuration Wizard by modifying the 
Communication port number. You can also change it in the Internet Proxy Settings 
page of the Administration Console by editing the Proxy listening port in the Internet 
Proxy communication type setting.

If you decide to not install the IPv6 protocol, each Mini Remote Control application 
communicates directly to the DameWare Internet Proxy instead of using port forwarding 
through the Central Server.

Common Error Messages
The following is a list of common errors encountered when installing DameWare and 
potential solutions to those errors. These errors are generally related to some type of 
system or network configuration issue within a network environment and can usually be 
duplicated outside of DameWare software.

Error Codes Error Potential Solutions 

System 
Error: 5

The credentials 
for the remote 
computer were 
rejected

 l The user account must have sufficient rights to 
logon locally to the remote computer. 

System 
Error: 51

Windows 
cannot find the 
network path

Verify that the network path is correct and the 
target computer is turned on

System 
Error: 53

Cannot connect 
to the remote 
computer

 l Ensure that File & Network sharing is enabled and 
the ports are open.

 l Check that the operating system is configured for 
Names Resolution.

 l Enable NetBios.

System 
Error: 1300

Not all 
privileges or 
groups 
referenced are 
assigned to the 
caller

This is frequently related to User Access Control 
or the Windows Firewall. Run the installer as an 
Administrator or login to the computer with the 
Administrator or Domain Administer account.

System 
Error: 1603

A fatal error 
occurred 
during 
installation

If you have uninstalled DameWare and try to 
reinstall it, you may need to remove the registry 
keys.
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Error Codes Error Potential Solutions 

System 
Error: 1707

The network 
address is 
invalid

This is related to the Novell Network Client. Try 
to connect with the host name or deploy the 
client agent with the MSI builder.

System 
Error: 1814

The specified 
resource name 
cannot be 
found in the 
image file

Some or all of the operating system's Standard 
Performance Indexes (counters) are either 
missing or corrupt. See KB 300092 for more 
information.

Winsock 
Connect 
Error: 10050

Cannot 
establish a 
connection to 
the remote 
computer

Ensure that the network is up, that you can 
access the remote computer, and that the 
firewall has not blocked the connection. 

Winsock 
Connect 
Error: 10054

The connection 
was forcibly 
closed by the 
remote 
computer

This can be caused if the application has 
stopped, the remote computer rebooted, the 
remote computer uses a hard close, or keep-
alive activity.

Winsock 
Connect 
Error: 10060

Connection 
timed out

This may be due to a firewall configuration 
issue, a names resolution issue, or a network 
routing issue.

Winsock 
Connect 
Error: 10061

The remote 
computer 
actively 
refused the 
connection

 l Reset the TCP port on both local and remote com-
puters. 

 l Ensure that the default TCP port is the same on 
both local and remote computers. 

 l Ensure that no other program is using the TCP 
port.

Winsock 
Connect 
Error: 11001

Host not found The host name could not be found in the 
database queried. Check that you can access the 
host with the name or use the IP address

Winsock 
Connect 
Error: 11004

Could not 
resolve the 
host name 

Check your DNS table or use the IP address 
instead

For more information on common errors, see KB 300005.
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Internet Session Licenses
Internet Sessions allow technicians on your internal network to access user computers 
that are on a public network. The Internet Session feature is included with the 
Centralized Remote Support license and depends on the installation and configuration of 
the DameWare Central Server and the DameWare Internet Proxy. Any Remote Support  
users established on the DameWare Central Server are licensed to create multiple 
Internet Sessions when the DameWare Internet Proxy is configured. 

Note: Only users with a  Remote Support  license can access the Internet Session feature.

Removing the Security Error for Internet Sessions
The DameWare Internet Proxy installs and binds a self-signed certificate to port 443 for 
secure communication between the DameWare applications and DameWare agents. If a 
certificate is already bound to the port, DameWare does not install the self-signed 
certificate.

Users who do not have the Mini Remote Control client agent installed on their computers 
are prompted to download and install either an Internet Session agent or a Mini Remote 
Control client agent from the DameWare Internet Proxy. If you use the self-signed 
certificate, your users will encounter security warnings during the download and install 
process.

To prevent these security warnings, install and bind a certificate from a certificate 
authority to port 443 or your designated DameWare Internet Proxy port.

 1. After you have received your certificate from a third party certificate authority, 
logon to the DameWare Internet Proxy computer as an administrator.

 2. Run certmgr.msc.

 3. Copy the certificate to the local certificate store.

 4. Double-click the copied certificate, and click Install certificate.

 5. Run services.msc.

 6. Stop the DameWare Server service.

Open a command line prompt, and run the following command to remove the 
existing certificate: 

netsh http delete sslcert ipport=0.0.0.0:443

 7. In the Certificate Manager, view the details of the certificate you installed, and 
copy the certificate hash.

 8. In the command line prompt, run the following command to bind the certificate to 
the port: 
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netsh http add sslcert ipport=0.0.0.0:443 certhash={certificate_
hash} appid={appid-formated_number} certstorename=root

     Replace certificate_hash with the certificate hash you copied and replace appid-
formated_number with a number in the appid format, such as a12345678-db90-
4b66-8b01-88f7af2e36bf.

 9. Start the DameWare Server service.

Mobile Client Compatibility
Version 10 Mobile Clients can access version 11 of the Mobile Gateway without upgrading. 
However, v10 clients cannot access the Global Host List you create in the DameWare 
Central Server.

Version 11 Mobile Clients can access version 10 of the Mobile Gateway, but will see the 
Global Host List tab. When accessed, the Mobile Gateway returns an error since the 
Global Host List is not supported on v10.

Internet Sessions for End Users

Internet Session Link

Use the Internet Session Link to connect to a technician from your organization. The 
technician must send you the link information. This is generally accomplished using email 
or an instant message, though other communication methods can be used.

Internet Session Links usually look like the following:

 l https://domain.com:443/dwnl/?3285798686

 l https://domain.com:443/InternetHelp/dwnl/?3285798686

The bolded sections change based on your organization.

You can click on the link to join the Internet Session, or you can join the session 
manually. 

If you want to join the Internet Session manually, you must have a Mini Remote Control 
client agent already installed on your computer. If you do not, you are prompted to install 
an Internet Session agent when you click on the link.

To join the session manually:

 1. Copy the Internet Session Link.

 2. Open your Mini Remote Control agent.

 3. Select Join Session.

 4. Paste the Internet Session link into the prompt.

 5. Click Join Session.
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Notes:

 l You may receive a security exception when you activate the link. Before accepting, 
ensure that the Internet Session Link is from your organization.

 l Depending on your browser, you may be prompted to allow the website to run the 
DameWare product.

What is an Internet Session

An Internet Session allows technicians working from within your organization's network 
to help those outside your internal network.

Internet Sessions must be initiated by the technician within your network. The technician 
sends an Internet Session Link to the person outside the network. When the person joins 
the Internet Session, the technician can access the computer and provide help.

If your computer has a Mini Remote Control agent installed on it, certain settings may 
hinder your ability to join an Internet Session. To check your settings, right-click the 
agent icon in your notification area and select Settings.

The following settings can negatively affect the Internet Session:

 l Absolute Timeout (General Tab) - This controls how long the Mini Remote Control 
agent allows connections.

 l Shared Secret (Click Session in the General Tab) - If enabled, you will not be able 
to join Internet Sessions.

 l Show Tray Icon (Additional Settings) - If disabled, you cannot join Internet 
Sessions manually.

 l Only allow connection when at Logon Desktop (Additional Settings) - If 
enabled, you cannot join Internet Sessions.

Joining an Internet Session

The easiest way to join an Internet Session is to click on the Internet Session link when 
the Mini Remote Control client agent is already installed on your computer. You will be 
automatically connected to the Internet Session.

The MRC client agent is a software component deployed to remote computers to allow the 
Mini Remote Control application to control them.

If you do not have a Mini Remote Control client agent installed on your computer, click on 
the Internet Session link to download and run the Internet Session agent which lets you 
join the Internet Session. The Internet Session agent is a single-use agent that must be 
downloaded each time you join an Internet Session.
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Notes: 

 l If you connect to the Internet using a proxy service, you will not be able to join an 
Internet Session.

 l You may encounter website security errors when attempting to download the 
Internet Session agent. After ensuring that the link is from your organization, you 
can follow the instructions in this Microsoft KB article to resolve the issue.

Use the links below to view browser specific instructions:

 l Internet Explorer              
 l Firefox              
 l Chrome              

Joining an Internet Session in Internet Explorer

 1. Click the Internet Session link. You may be prompted with the following Security 
Warning Dialog. 

 l If you are sure the Internet Session link is from an authorized technician in 
your organization, click No to download the DameWare Internet Session 
Agent. 

 l If you click Yes, the Internet Session Agent will not download to your com-
puter, and you will not be able to connect to the Internet Session.

 2. Double-click the file to open it. You can download it again if necessary.

 3. Run the DameWareInternetSession.exe file.

 4. If prompted, confirm that you want to run the DameWare Internet Session Agent.

 5. When the connection is complete, you are prompted to Accept or Decline the 
connection.

 l Click Accept to complete the connection.

 l Click Decline to end the connection.

Joining an Internet Session in Firefox

 1. Click the Internet Session link. You may be prompted with the following Security 
Warning Dialog. 

 l If you are sure the Internet Session link is from an authorized technician in 
your organization, click No to download the DameWare Internet Session 
Agent. 

 l If you click Yes, the Internet Session Agent will not download to your com-
puter, and you will not be able to connect to the Internet Session.

 2. Click the Download button in the right, top corner next to the address bar, and click 
the file to open it.
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 3. When prompted to open the DameWareInternetSession.exe file, click Run.

 4. When prompted to launch the DameWareInternetSession.exe file, select 
DameWare products, and click OK.

 5. When the connection is complete, you are prompted to Accept or Decline the 
connection. 

 l Click Accept to complete the connection.

 l Click Decline to end the connection.

Joining an Internet Session in Chrome

 1. Click the Internet Session link. You may be prompted with the following Security 
Warning Dialog. 

 l If you are sure the Internet Session link is from an authorized technician in 
your organization, click No to download the DameWare Internet Session 
Agent. 

 l If you click Yes, the Internet Session Agent will not download to your com-
puter, and you will not be able to connect to the Internet Session.

 2. You may be prompted with an External Protocol Request dialog to launch the 
Internet Session Agent. Click Launch Application. If you click Do Nothing, the 
Internet Session Agent will not download to your computer.

 3. Double-click the file to open it.

 4. When prompted to open the DameWareInternetSession.exe file, click Run.

 5. When prompted again to run the DameWareInternetSession.exe file, click Run.

 6. Confirm the Internet Session when prompted.

 7. When the connection is complete, you are prompted to Accept or Decline the 
connection. 

 l Click Accept to complete the connection.

 l Click Decline to end the connection.
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